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About This Guide

Purpose

The Applied Biosystems' AmpFISTR™ NGM™ PCR Amplification Kit User Guide
provides information about our instruments, chemistries, and software associated

with the AmpF(STR™ NGM ™ PCR Amplification Kit.
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B Materials and equipment ............. . i 17
Product overview
Purpose The AmpF(STR™ NGM™ PCR Amplification Kit is a short tandem repeat (STR)

multiplex assay that amplifies 14 tetranucleotide repeat loci and one trinucleotide
repeat locus, D2251045. The kit simultaneously coamplifies the 10 loci contained in the
AmpFSTR™ SGM Plus™ Kit (D351358, vWA, D165539, D251338, D851179, D21511,
D18551, D195433, THO1, and FGA) together with 2 highly polymorphic STR loci
(D1S1656 and D12S391), 3 “mini” STR loci (D1051248, D2251045 and D25441), and the
gender determination locus Amelogenin. The NGM " Kit delivers a 16-locus multiplex
with a greater power of discrimination, better sensitivity, and improved robustness
than earlier generation AmpF(STR ™ kits. The kit uses modified PCR cycling
conditions for enhanced sensitivity, a new buffer formulation to improve
performance with inhibited samples, more loci concentrated in the low molecular-
weight region of the profile to improve performance on degraded samples, and an
improved process for synthesis and purification of the amplification primers to
deliver a much cleaner electrophoretic background.

Product The NGM " Kit contains all the necessary reagents for the amplification of human
description genomic DNA.
The reagents are designed for use with the following Applied Biosystems™
instruments:

e ABIPRISM " 3100/3100-Avant Genetic Analyzer

e Applied Biosystems'" 3130/3130x! Genetic Analyzer

* Applied Biosystems'" 3500/3500xL Genetic Analyzer

* Applied Biosystems'" 310 Genetic Analyzer

e GeneAmp " PCR System 9700 with the Silver 96-Well Block

* GeneAmp"" PCR System 9700 with the Gold-plated Silver 96-Well Block
* Veriti"" 96-Well Thermal Cycler

e ProFlex" PCR System

AmpFISTR™NGM™ PCR Amplification Kit User Guide 11



About the primers

Loci amplified by
the kit

Chapter 1 Overview
Product overview

The NGM™ Kit employs the latest improvements in primer synthesis and purification
techniques to minimize the presence of dye-labeled artifacts. These improvements
result in a much cleaner electropherogram background that enhances the assay's
signal-to-noise ratio and simplifies the interpretation of results.

The following table shows the loci amplified, their chromosomal locations, and the

corresponding fluorescent marker dyes. The AmpF(STR™ NGM™ Allelic Ladder is
used to genotype the analyzed samples. The alleles contained in the allelic ladder and

the genotype of the AmpF(STR™ Control DNA 007 are also listed in the table.

Table 1 NGM™ Kit loci and alleles

Locus desianation Chromosome Alleles included in AmpF{(STR™ Dye ControlDNA
9 location NGM™ Allelic Ladder label 007

D1051248 10926.3 8,9, 10, 11, 12, 13, 14, 15, 16, 17, 18 6-FAM™ | 12,15

VWA 12p13.31 11,12, 13, 14,15, 16, 17, 18, 19, 20, 21, 22, | 6-FAM™ | 14, 16
23, 24

D165539 16q24.1 5,8, 9 10,11, 12,13, 14, 15 6-FAM™ 9,10

D251338 2935 15,16, 17, 18, 19, 20, 21, 22, 23, 24, 25, 26, | 6-FAM™ | 20, 23
27, 28

Amelogenin X: p22.1-22.3 XY vic™ XY

Y: p11.2

D851179 8424.13 8,910, 11, 12, 13, 14, 15, 16, 17, 18, 19 vic™ 12,13

D21511 21911.2-921 24, 24.2, 25, 26, 27, 28, 28.2, 29, 29.2, 30, vic™ 28, 31
30.2,31,31.2,32,32.2, 33, 33.2, 34, 34.2, 35,
35.2, 36, 37, 38

D18551 18q21.33 7,9, 10, 10.2, 11, 12, 13, 13.2, 14, 14.2, 15, | vIC™ 12,15
16, 17, 18, 19, 20, 21, 22, 23, 24, 25, 26, 27

D2251045 22912.3 8,9, 10,11, 12, 13, 14, 15, 16, 17, 18, 19 NED™ 11,16

D195433 19912 9,10, 11,12, 12.2, 13, 13.2, 14, 14.2, 15, NED™ 14,15
15.2, 16, 16.2, 17, 17.2

THO1 11p15.5 4,5,6,7,8, 9 93,10, 11, 13.3 NED™ 7,9.3

FGA 428 17,18, 19, 20, 21, 22, 23, 24, 25, 26, 26.2, 27, | NED™ 24, 26
28, 29, 30, 30.2, 31.2, 32.2, 33.2, 42.2, 43.2,
442, 45.2, 46.2, 47.2, 48.2, 50.2, 51.2

D2S441 2pl4 9,10, 11, 11.3, 12, 13, 14, 15, 16 PET™ 14,15

D351358 3p21.31 12,13, 14, 15, 16, 17, 18, 19 PET™ 15, 16

D151656 1q42.2 9,10, 11, 12,13, 14, 14.3, 15, 15.3, 16, 16.3, | PET™ 13, 16
17,17.3, 18.3, 19.3, 20.3

D125391 12p13.2 14,15, 16,17, 18,19, 19.3, 20, 21, 22, 23, 24, | PET™ 18, 19
25, 26, 27

12 AmpFISTR™NGM™ PCR Amplification Kit User Guide



Chapter 1 Overview 1
Product overview

Allelic ladder Figure 1 shows the allelic ladder for the NGM ™ Kit. See “Allelic ladder requirements”

profile on page 25 for information on ensuring accurate genotyping.

Figure 1 GeneMapper™ ID-X Software plot of the AmpF(STR™ NGM™ Allelic Ladder
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Chapter 1 Overview
Product overview

Control DNA 007 Figure 2 shows amplification of Control DNA 007 using the NGM ™ Kit.
profile

Figure 2 1 ng of Control DNA 007 amplified with the NGM™ Kit and analyzed on the Applied Biosystems™ 3130x(
Genetic Analyzer
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Workflow overview

Chapter 1 Overview 1
Workflow overview
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This section provides information about the Data Collection Software versions
required to run the NGM " Kit on specific instruments.

The Data Collection Software provides instructions to firmware running on the
instrument and displays instrument status and raw data in real time. As the
instrument measures sample fluorescence with its detection system, the Data
Collection Software collects the data and stores it. The Data Collection Software stores
information about each sample in a sample file (.fsa files for 31xx instruments

and .hid files for 3500 instruments), which is then analyzed by the GeneMapper " ID
or ID-X Software.

Table 2 Software specific to each instrument

Data Collection

Instrument Software Analysis software
3500/3500xL 3500 Series Data GeneMapper™ ID-X
Collection Software v1.0 | Software v1.2 or higher
3130/3130x(* 3.0 o GeneMapper™ ID Software
v3.2.1
3100/3100-Avant | 1.1 (3100)
and
1.0 (3100-Avant) « GeneMapper™ ID-X
20 Software v1.0.1 or higher
310 3.1
3.0

+ We conducted validation studies for the NGM™ Kit using this configuration.

Our fluorescent multi-color dye technology allows the analysis of multiple loci,
including loci that have alleles with overlapping size ranges. Alleles for overlapping
loci are distinguished by labeling locus-specific primers with different colored dyes.

Multicomponent analysis is the process that separates the 5 different fluorescent dye
colors into distinct spectral components. The four dyes used in the NGM"" Kit to label
samples are 6-FAM"", VIC"™, NED"™, and PET " dyes. The fifth dye, LIZ"", is used to

label the GeneScan™ 500 LIZ™ Size Standard or GeneScan"" 600 LIZ™ Size Standard
v2.0.

Each of these fluorescent dyes emits its maximum fluorescence at a different
wavelength. During data collection on the Applied Biosystems'" and ABI PRISM
instruments, the fluorescence signals are separated by diffraction grating according to
their wavelengths and projected onto a charge-coupled device (CCD) camera in a
predictably spaced pattern. The 6-FAM"™ dye emits at the shortest wavelength and it
is displayed as blue, followed by the VIC™ dye (green), NED" dye (yellow), PET""
dye (red), and LIZ" dye (orange).

AmpFISTR™NGM™ PCR Amplification Kit User Guide



Chapter 1 Overview
Materials and equipment

Although each of these dyes emits its maximum fluorescence at a different
wavelength, there is some overlap in the emission spectra between the dyes (Figure 3).
The goal of multicomponent analysis is to correct for spectral overlap.

Figure 3 Emission spectra of the five dyes used in the NGM™ Kit
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Materials and equipment

Kit contents and
storage

The NGM™ Kit contains materials sufficient to perform 200 (Part no. 4415020) or 1000
(Part no. 4415021) amplifications at a 25 pL reaction volume.

IMPORTANT! The fluorescent dyes attached to the primers are light-sensitive. Protect
the primer set, amplified DNA, allelic ladder, and size standards from light when not
in use. Keep freeze-thaw cycles to a minimum.

Table 3 Kit contents and storage

Component

Description

200X Volume

1000X Volume

Storage

AmpF(STR™NGM™
Primer Set

Contains forward and reverse
primers to amplify human DNA
targets.

1 tube, 1.0 mL

1 bottle, 5.0 mL

-15 to -25°C on
receipt, 2 to 8 °C
after initial use

AmpF(STR™NGM™
Master Mix

Contains enzyme, salts, dNTPs,
carrier protein, and 0.05%
sodium azide.

2 tubes, 1.0 mL
each

1 bottle, 10.0 mL

-15 to -25°C on
receipt, 2 to 8 °C
after initial use

AmpF(STR™NGM™
Allelic Ladder

Contains amplified alleles.

See Table 1 on page 12 for a list
of alleles included in the allelic
ladder.

1 tube, 50.0 pL

1 tube, 75.0 uL

-15 to -25°C on
receipt, 2 to 8°C
after initial use

AmpF(STR™
Control DNA 007

Contains 0.10 ng/pL human male
007 DNA in 0.02% sodium azide
and buffer?.

See Table 1 on page 12 for
profile.

1 tube, 0.3 mL

1 tube, 0.3 mL

2 to 8°C

+ The AmpF(STR™ Control DNA 007 is included at a concentration appropriate to its intended use as an amplification control (to provide
confirmation of the capability of the kit reagents to generate a profile of expected genotype). The AmpF(STR™ Control DNA 007 is not designed
to be used as a DNA quantitation control, and laboratories may expect to see variation from the labelled concentration when quantitating
aliquots of the AmpF(STR™ Control DNA 007.

AmpFISTR™NGM™ PCR Amplification Kit User Guide 17
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Materials and equipment

Standards for For the NGM " Kit, the panel of standards needed for PCR amplification, PCR product
samples sizing, and genotyping are:
¢ Control DNA 007 — A positive control for evaluating the efficiency of the

amplification step and STR genotyping using the AmpF(STR™ NGM ™ Allelic
Ladder.

e GeneScan'" 500 LIZ™ Size Standard (GS 500) or GeneScan"" 600 LIZ™ Size
Standard v2.0 (GS 600 v2.0) — Used for obtaining sizing results. These standards,
which have been evaluated as internal size standards, yield precise sizing results
for NGM™ Kit PCR products. Order the GeneScan™ 500 LIZ™ Size Standard
(Part no. 4322682) or the GeneScan"" 600 LIZ™ Size Standard v2.0
(Part no. 4408399) separately.

e AmpFSTR™ NGM™ Allelic Ladder — Allelic ladder for accurate characterization
of the alleles amplified by the NGM ™ Kit. The AmpF/(STR™ NGM ™ Allelic Ladder
contains most of the alleles reported for the 15 autosomal loci. Refer to Table 1 on

page 12 for a list of the alleles included in the AmpF(STR™ NGM™ Allelic Ladder.

18 AmpFISTR™NGM™ PCR Amplification Kit User Guide
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Required user-supplied materials and reagents

In addition to the NGM " Kit reagents, the use of low-TE buffer
(10 mM Tris, 0.1 mM EDTA, pH 8.0) is recommended. You can prepare the buffer as
described in the procedure below or order it from Teknova (Cat. no. T0223).

To prepare low-TE buffer:
1. Mix together:
e 10mL of 1 M Tris-HCI, pH 8.0
e 0.2mL of 0.5 M EDTA, pH 8.0
* 990 mL glass-distilled or deionized water

Note: Adjust the volumes based on your specific needs.
2. Aliquot and autoclave the solutions.

3. Store at room temperature.

DNA gquantification

Importance of Quantifying the amount of DNA in a sample before amplification allows you to
quantification determine whether or not sufficient DNA is present to permit amplification and to
calculate the optimum amount of DNA to add to the reaction. The optimum amount of
DNA for the NGM ™ Kit is 1.0 ng in a maximum input volume of
10 pL amplified for 29 cycles.

AmpFISTR™NGM™ PCR Amplification Kit User Guide 19



DNA quantification

Chapter 2 PCR Amplification

If too much DNA is added to the PCR reaction, then the increased amount of PCR
product that is generated can result in:

¢ Fluorescence intensity that exceeds the linear dynamic range for detection by the

instrument (“off-scale” data). Off-scale data are problematic because:

— Quantification (peak height and area) for off-scale peaks is not accurate. For
example, an allele peak that is off-scale can cause the corresponding stutter
peak to appear higher in relative intensity, thus increasing the calculated
percent stutter.

— Multicomponent analysis of off-scale data is not accurate, and it results in
poor spectral separation (“pull-up”).

¢ Incomplete A-nucleotide addition.

When the total number of allele copies added to the PCR is extremely low, allelic
dropout can occur, resulting in a partial profile.

Methods of
quantifying DNA

We provide several kits for quantifying DNA in samples. See the references cited in the
following table for details about these kits.

Product

Description

Quantifiler™ Human DNA
Quantification Kit
(Part no.4343895)

and

Quantifiler™ Y Human Male
DNA Quantification Kit
(Part no. 4343906)

For more information, see
Quantifiler™ Human DNA
Quantification Kits User's Manual
(Part no. 4344790)

Properties:

The Quantifiler™ Human and Quantifiler™ Y Human Male Kits are highly specific for
human DNA, and they detect total human or male DNA, respectively. The kits detect
single-stranded and degraded DNA.

How they work:

The Quantifiler™ DNA Quantification Kits consist of target-specific and internal control 5’
nuclease assays.

The Quantifiler™ Human and Quantifiler™ Y Human Male Kits contain different target-
specific assays (human DNA or human male DNA, respectively) that each consist of two
locus-specific PCR primers and one TagMan™ MGB probe labeled with FAM™ dye for
detecting the amplified sequence. The kits each contain a separate internal PCR control
(IPC) assay that consists of an IPC template DNA (a synthetic sequence not found in
nature), two primers for amplifying the IPC template DNA, and one TaqMan™ MGB
probe labeled with VIC™ dye for detecting the amplified IPC DNA.

Quantifiler™ Duo DNA
Quantification Kit
(Part no. 4387746)

For more information, see
Quantifiler™ Duo DNA
Quantification Kit User's Manual
(Part no. 4391294)

Properties:

The Quantifiler™ Duo Kit is highly specific for human DNA and combines the
detection of both total human and male DNA in one PCR reaction.The kit detects
single-stranded and degraded DNA.

How it works:

The Quantifiler™ Duo DNA Quantification Kit consists of target-specific and internal
control 5" nuclease assays.

The Quantifiler™ Duo Kit combines two human-specific assays in one PCR reaction
(for total human DNA and human male DNAJ. The two human DNA specific assays
each consist of two PCR primers and a TagMan™ probe. The TagMan™ probes for the
human DNA and human male DNA assays are labeled with VIC™ and FAM™ dyes,
respectively. In addition, the kit contains an internal PCR control (IPC) assay similar
in principle to that used in the other Quantifiler Kits, but labeled with NED™ dye.
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Prepare the amplification kit reactions

Product

Description

Quantifiler™ HP DNA
Quantification Kit (Cat. no.
4482911)

Quantifiler™ Trio DNA
Quantification Kit (Cat. no.
4482910)

For more information, see
Quantifiler HP and Trio DNA
Quantification Kits User Guide
(Pub no. 4485354)

Properties:

The Quantifiler™ HP Kit is designed to quantify the total amount of amplifiable human
DNA in a sample. The Quantifiler™ Trio Kit is designed to simultaneously quantify the
total amount of amplifiable human DNA and human male DNA in a sample.

How they work:

The Quantifiler™ HP and Trio DNA Quantification Kits use multiple-copy target loci for
improved detection sensitivity. The human-specific target loci (Small Autosomal, Large
Autosomal, and Y-chromosome targets] each consist of multiple copies dispersed on
various autosomal chromosomes (Small Autosomal and Large Autosomall.

To maximize the consistency of quantification results, genomic targets were selected
with conserved primer- and probe-binding sites within individual genomes and also with
minimal copy number variability between different individuals and population groups. As
a result, the detection sensitivity of the Quantifiler™ HP and Trio assays is improved over
Quantifiler™ Duo, Human, and Y Human Male DNA Quantification Kit assays. The
primary quantification targets (Small Autosomal and Y] consist of relatively short
amplicons (75 to 80 bases) to improve the detection of degraded DNA samples. In
addition, the Quantifiler™ HP and Trio Kits each contain a Large Autosomal target with a
longer amplicon (>200 bases) to aid in determining if a DNA sample is degraded.

Prepare the amplification kit reactions

1.

N

w

A

Calculate the volume of each component needed to prepare the reactions, using
the table below.

DNA sample Volume per reaction
AmpF(STR™ NGM™ Master Mix 10.0 pL
AmpF(STR™ NGM™ Primer Set 5.0 uL

Note: Include additional reactions in your calculations to provide excess volume
for the loss that occurs during reagent transfers.

. Prepare reagents. Thaw the AmpF(STR"™ NGM"" Master Mix and the AmpF(STR ™

NGM"™ Primer Set, then vortex the tubes for 3 seconds and centrifuge them
briefly before opening.

IMPORTANT! Thawing is required only during first use of the kit. After first use,
reagents are stored at 2-8°C and, therefore, do not require subsequent thawing.
Do not refreeze the reagents.

. Pipet the required volumes of components into an appropriately sized

polypropylene tube.
Vortex the reaction mix for 3 seconds, then centrifuge briefly.

Dispense 15 pL of reaction mix into each reaction well of a MicroAmp™™
Optical
96-Well Reaction Plate or each MicroAmp '™ tube.
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Perform PCR

6. Prepare the DNA samples:

DNA sample To prepare...
Negative control = Add 10 pL of low-TE buffer (10mM Tris, 0.1mM EDTA, pH 8.0).
Test sample Dilute a portion of the test DNA sample with low-TE buffer so

that 1.0 ng of total DNA is in a final volume of 10 yL. Add 10 pL
of the diluted sample to the reaction mix.

Positive control Add 10 pL of 007 control DNA (0.1 ng/pL) to provide 1.0 ng of
total DNA in the positive control reaction.

The final reaction volume (sample or control plus reaction mix) should be 25 pL.

7. Seal the MicroAmp"" Optical 96-Well Reaction Plate with MicroAmp™" Clear
Adhesive Film or MicroAmp"" Optical Adhesive Film, or cap the tubes.

8. Centrifuge the tubes or plate at 3000 rpm for about 20 seconds in a tabletop
centrifuge (with plate holders if using 96-well plates) to remove bubbles.

9. Amplify the samples in a GeneAmp'" PCR System 9700 with the Silver 96-well
block, or a GeneAmp'" PCR System 9700 with the Gold-plated Silver 96-well
block, or a Veriti™ 96-well Thermal Cycler, or a ProFlex™ PCR System.

IMPORTANT! The NGM"™ Kit is not validated for use with the GeneAmp™"
PCR System 9700 with the Aluminium 96-well block. Use of this thermal

cycling platform may adversely affect the performance of the NGM"" Kit.

Perform PCR

1. Program the thermal cycling conditions.

* When using the GeneAmp'" PCR System 9700 with either 96-well silver or
gold-plated silver block, select the 9600 Emulation Mode.

* When using the Veriti"" 96-Well Thermal Cycler, refer to the following
document for instructions on how to configure the Veriti instrument to run
in the 9600 Emulation Mode: User Bulletin: Veriti' 96-Well Thermal Cycler
AmpF(STR™ Kit Validation (Part no. 4440754).

* When using the ProFlex"" PCR System, refer to the ProFlex"" PCR System Kit
Validation User Bulletin (Pub. no. 100031595) for more information.

Initial Cycle (29/30 cycles) Final Final hold
incubation step Denature ‘ Anneal extension
HOLD CYCLE HOLD HOLD
95°C 94°C 59°C 60°C 4°C
11 min 20 sec 3 min 10 min )
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Amplification using bloodstained FTA™ cards

IMPORTANT! The NGM " Kit is validated for use at both 29 and 30 cycles. The
optimum conditions for the NGM"" Kit are 29 cycles of amplification with a 1 ng
input DNA concentration. If using the NGM"" Kit at 30 cycles, reduce the input
DNA concentration to 500 pg. Perform internal validation studies to evaluate kit
performance at each cycle number intended for operational use.

2. Load the plate or tubes into the thermal cycler and close the heated cover.

IMPORTANT! If using the 9700 thermal cycler with silver or gold-plated silver
block and adhesive clear film instead of caps to seal the plate wells, be sure

to place a MicroAmp™ compression pad (Part no. 4312639) on top of the
plate to prevent evaporation during thermal cycling.

3. Start the run.

4. On completion of the run, store the amplified DNA and protect from light.

If you are storing the DNA... Then place at...
< 2 weeks 2 to 8°C
> 2 weeks -15t0-25°C

IMPORTANT! Store the amplified products so that they are protected from light.

Amplification using bloodstained FTA™ cards

FTA™ cards can be useful for the collection, storage, and processing of biological
samples. A small punch disc of the card containing the sample can be placed directly
into an amplification tube, purified, and amplified, without transferring the disc. Our
studies indicate that a 1.2-mm bloodstained disc contains approximately 5-20 ng
DNA. An appropriate cycle number for this high quantity of DNA is 24 cycles,
determined by our validation studies. Perform internal validation studies to evaluate
kit performance at each cycle number intended for operational use.

In the example shown in Figure 4, a 1.2-mm disc of a bloodstained FTA™ card was
purified using three washes with FTA™ Purification Reagent and two washes with
1X low-TE buffer. The punch was then amplified directly in the MicroAmp"" tube for
24 cycles.
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Figure 4 NGM™ Kit results from a 1.2-mm FTA™ bloodstain disc (24-cycle amplification), analyzed on

the Applied Biosystems™ 3130x! Genetic Analyzer
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Allelic ladder requirements

To accurately genotype samples, you must run an allelic ladder sample along with the
unknown samples.

Number of One .
. L Number of samples per allelic
Instrument allelic ladders injection
ladder(s)
to run equals

3100-Avant or 3130 | 1 per 4 injections | 4 samples 15 samples + 1 allelic ladder

3100 or 3130x( 1 per injection 16 samples 15 samples + 1 allelic ladder
3500 1 per 3 injections | 8 samples 23 samples + 1 allelic ladder
3500xL 1 per injection 24 samples | 23 samples + 1 allelic ladder
310 1 per 10 samples | 1 sample 9 samples + 1 allelic ladder

IMPORTANT! Variation in laboratory temperature can cause changes in fragment
migration speed and sizing variation between both single- and multiple-capillary runs
(with larger size variations seen between samples injected in multiple-capillary runs).
We recommend the above frequency of allelic ladder injections, which should account
for normal variation in run speed. However, during internal validation studies, verify
the required allelic ladder injection frequency to ensure accurate genotyping of all
samples in your laboratory environment.
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3 Chapter 3 Electrophoresis
Allelic ladder requirements

It is critical to genotype using an allelic ladder run under the same conditions as the
samples, because size values obtained for the same sample can differ between
instrument platforms because of different polymer matrices and electrophoretic
conditions.
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Section 3.1 3100/3100-Avant and 3130/3130xl instruments 3
Set up the 3100/3100-Avant and 3130/3130x!l instruments for electrophoresis

Section 3.1 3100/3100-Avant and 3130/3130x!
instruments

Set up the 3100/3100-Avant and 3130/3130x! instruments for
electrophoresis

Reagents and parts Appendix B, “Ordering Information” on page 107 lists the required materials not
supplied with the NGM™ Kit.

IMPORTANT! The fluorescent dyes attached to the primers are light-sensitive. Protect
the primer set, amplified DNA, allelic ladder, and size standard from light when not in
use. Keep freeze-thaw cycles to a minimum.

Electrophoresis The following table lists data collection software and the run modules that can be used
software setupand  to analyze NGM" Kit PCR products. For details on the procedures, refer to the
documents listed in the table.

reference
documents
. Data .
fnear:e::r Collection 02e::$g Run modules and conditions References
4 Software ¥
Applied 3.0t Windows™ e HIDFragmentAnalysis36_POP4_1 | Applied Biosystems™ 3130/3130x!
Biosystems™ XP Injection conditions: Genetic Analyzers Using Data
3130/3130x! Collection Software v3.0, Protocols
- 3130 =3 kV/5 ’
/5 sec for Processing AmpF(STR™ PCR
- 3130 =3 kV/10 sec Amplification Kit PCR Products User
e Dye Set G5 Bulletin (Part no. 4363787)
ABI PRisM™ 2.0 Windows™ e HIDFragmentAnalysis36_POP4_1 = ABI Prism™ 3100/3100-Avant
3100 2000 Injection condition: 3kV/10 sec Genetic Analyzers Using Data
e Dve Set G5 Collection Software v2.0, Protocols
y for Processing AmpFISTR™ PCR
Amplification Kit PCR Products User
Bulletin (Part no. 4350218)
1.1 Windows™ ¢ GeneScan36vb_DyeSetG5Module | ABI Prism™ 3100/3100-Avant Genetic
NT Injection condition: 3kV/10 sec Analyzers Protocols for Processing
. , AmpFISTR™ PCR Amplification Kit
G5600v2.0Analysis.gsp PCR Products User Bulletin
(Part no. 4332345)
ABI PrisM™ 1.0 Windows™ e GeneScan36Avb_DyeSetG5Module = AB/ Prism™ 3100/3100-Avant Genetic
3100-Avant NT Injection condition: 3 kV/5sec Analyzers Protocols for Processing
. AmpFISTR™ PCR Amplification Kit PCR
. 2.0Analysis.
G5600v2.0Analysis.gsp Products User Bulletin
(Part no. 4332345)

T We conducted validation studies for the <Short form of the primary product name> using this configuration.
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3 Chapter 3 Electrophoresis
Prepare samples for electrophoresis on the 3100/3100-Avant or 3130/3130x! instruments

Prepare samples for electrophoresis on the 3100/3100-Avant or
3130/3130x! instruments

Prepare the samples for electrophoresis on the 3100/3100-Avant or 3130/3130x]
immediately before loading.

1. Calculate the volume of Hi-Di"" Formamide and size standard needed to prepare
the samples:

Reagent Volume per reaction
GS 500 LIZ™ Size Standard or 0.5 pL
GS 600 LIZ™ Size Standard v2.0
Hi-Di™ Formamide 9.5 uL

Note: Include additional samples in your calculations to provide excess volume
for the loss that occurs during reagent transfers.

IMPORTANT! The volume of size standard indicated in the table is a suggested
amount. Determine the appropriate amount of size standard based on your
experiments and results.

2. Pipet the required volumes of components into an appropriately sized
polypropylene tube.

3. Vortex the tube, then centrifuge briefly.

4. Into each well of a MicroAmp"" Optical 96-Well Reaction Plate, add:
* 10 pL of the formamide:size standard mixture

¢ 1 pL of PCR product or Allelic Ladder
Note: For blank wells, add 11 pL of Hi-Di"" Formamide.

5. Seal the reaction plate with appropriate septa, then briefly vortex and centrifuge
the plate to ensure that the contents of each well are mixed and collected at the
bottom.

Heat the reaction plate in a thermal cycler for 3 minutes at 95°C.
Immediately place the plate on ice for 3 minutes.

Prepare the plate assembly on the autosampler.

 ® N o

Start the electrophoresis run.
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Chapter 3 Electrophoresis 3
Set up the 3500/3500xL instrument for electrophoresis

Section 3.2 3500/3500xL instruments

Set up the 3500/3500xL instrument for electrophoresis

Reagents and parts

Electrophoresis
software setup and
reference

Appendix B, “Ordering Information” on page 107 lists the required materials not
supplied with the NGM ™ Kit.

IMPORTANT! The fluorescent dyes attached to the primers are light-sensitive. Protect
the primer set, amplified DNA, allelic ladder, and size standard from light when not in
use. Keep freeze-thaw cycles to a minimum.

The following table lists Data Collection Software and the run modules that can be
used to analyze NGM"" Kit PCR products. For details on the procedures, refer to the
documents listed in the table.

documents
. Data .
Genetic Collection Operating Run modules and conditions References
Analyzer System
Software
Applied 3500 Data | Windows™ | e HID36_POP4 Applied Biosystems™ 3500/
Biosystems™ Collection | XP Injection conditions: 1.2kV/15 sec 3500xL Genetic Analyzer User
3500 Software Guide (Part no. 4401661)
1.0 or e Dye Set G5
Applied Windows s HID36_POP4 3500 and 3500xL. Genetic
) ™ L o o Analyzers Quick Reference Card
Biosystems Vista Injection conditions: 1.2kV/24 sec (Part no. 4401662)
3500xL .
¢ Dye Set G5

Prepare samples for electrophoresis on the 3500/3500xL

instrument

Prepare the samples for capillary electrophoresis on the 3500/3500xL instrument
immediately before loading.

1. Calculate the volume of Hi-Di"" Formamide and Size Standard needed to prepare
the samples, using the table below.

AmpFISTR™NGM™ PCR Amplification Kit User Guide

Reagent Volume per reaction
GeneScan™ 600 LIZ™ Size Standard v2.0 05 uL
Hi-Di™ Formamide 9.5 uL

Note: Include additional samples in your calculations to provide excess volume

for the loss that occurs during reagent transfers.
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Chapter 3 Electrophoresis

Prepare samples for electrophoresis on the 3500/3500xL instrument

© ® ® N o

IMPORTANT! The volume of size standard indicated in the table is a suggested
amount. Determine the appropriate amount of size standard based on your
results and experiments.

Pipet the required volumes of components into an appropriately sized
polypropylene tube.

Vortex the tube, then centrifuge briefly.

Into each well of a MicroAmp"" Optical 96-Well Reaction Plate, or
each MicroAmp " optical strip tube, add:

a. 10 pL of the formamide: size standard mixture
b. 1 uL of PCR product or allelic ladder

Note: For blank wells, add 11 pL of Hi-Di"" Formamide.

Seal the reaction plate or strip tubes with the appropriate septa, then centrifuge to
ensure that the contents of each well are collected at the bottom.

Heat the reaction plate or strip tubes in a thermal cycler for 3 minutes at 95°C.
Immediately put the plate or strip tubes on ice for 3 minutes.

Prepare the plate assembly, then put it onto the autosampler.

Ensure that a plate record is completed and link the plate record to the plate.

Start the electrophoresis run.
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Set up the 310 iS:t?frtnee:)? foEl:thcrt(;::hoorreei:
Section 3.3 310 instruments

Set up the 310 instrument for electrophoresis

Reagents and parts Appendix B, “Ordering Information” on page 107 lists the required materials not
supplied with the NGM ™ Kit.

IMPORTANT! The fluorescent dyes attached to the primers are light-sensitive. Protect
the primer set, amplified DNA, allelic ladder, and size standard from light when not in
use. Keep freeze-thaw cycles to a minimum.

Electrophoresis The following table lists Data Collection Software and the run modules that can be
software setup and used to analyze NGM"" Kit PCR products. For details on the procedures, refer to the
documents listed in the table.

reference
documents
Data Operatin
Collection P 9 Run modules and conditions References
System
Software
317 Windows XP | ¢ GS STR POP4 (1mL) G5 v2.md5 =~ ABI PRisM™ 370 Genetic Analyzer User’s Manual
or or Injection condition: (Windows) (Part no. 4317588)
3.0t Windows 15 kV/5 sec ABI PrRISM™ 310 Protocols for Processing
NT™ and AmpFISTR™ PCR Amplification Kit Products
Windows with Microsoft Windows NT Operating System:
2000 User Bulletin (Part no. 4341742)

+ We conducted concordance studies for the NGM™ Kit using this configuration.

Prepare samples for electrophoresis on the 310 instrument

Prepare the samples for capillary electrophoresis on the 310 instrument immediately
before loading.

1. Calculate the volume of Hi-Di'" Formamide and Size Standard needed to prepare
the samples, using the table below.

Reagent Volume per reaction
GeneScan™ 500 LIZ™ Size Standard or 0.75 uL
GeneScan™ 600 LIZ™ Size Standard v2.0
Hi-Di™" Formamide 24.25 pL

Note: Include additional samples in your calculations to provide excess volume
for the loss that occurs during reagent transfers.
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3 Chapter 3 Electrophoresis
Prepare samples for electrophoresis on the 310 instrument

IMPORTANT! The volume of size standard indicated in the table is a suggested
amount. Determine the appropriate amount of size standard based on your
results and experiments.

2. Pipet the required volumes of components into an appropriately sized
polypropylene tube.

3. Vortex the tube, then centrifuge briefly.

4. Into each 0.2-mL or 0.5-mL sample tube, add:
a. 25 pL of the formamide: size standard mixture
b. 1.5 uL of PCR product or allelic ladder
Note: For blank wells, add 25 uL of Hi-Di"" Formamide.

5. Seal the tubes with the appropriate septa, then briefly centrifuge to ensure that
the contents of each tube are mixed and collected at the bottom.

Heat the tubes in a thermal cycler for 3 minutes at 95°C.
Immediately place the tubes on ice for 3 minutes.
Place the sample tray on the autosampler.

Ensure that an injection list is prepared.

© ® ® N o

Start the electrophoresis run.
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Section 4.1 GeneMapper™ ID Software

Overview of GeneMapper™ ID Software

Instruments

GeneMapper'" ID Software is an automated genotyping software for forensic
casework, databasing, and paternity data analysis.

After electrophoresis, the Data Collection Software stores information for each

sample in an .fsa file. Using GeneMapper " ID Software v3.2.1 software, you can then
analyze and interpret the data from the .fsa files.

Refer to “Instrument and software overview” on page 16 for a list of compatible
instruments.
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Set up GeneMapper™ ID Software for data

analysis

Before you start

When using GeneMapper'" ID Software v3.2.1 to perform human identification
(HID) analysis with AmpF(STR™ kits, be aware that:

HID analysis requires at least one allelic ladder sample per run folder. Perform
the appropriate internal validation studies if you want to use multiple ladder
samples in an analysis.

For multiple ladder samples, the GeneMapper'" ID Software calculates allelic bin
offsets by using an average of all ladders that use the same panel within a run
folder.

Allelic ladder samples in an individual run folder are considered to be from a
single run.

When the software imports multiple run folders into a project, only the ladder(s)
within their respective run folders are used for calculating allelic bin offsets and
subsequent genotyping.

Allelic ladder samples must be labeled as “Allelic Ladder” in the Sample Type
column in a project. Failure to apply this setting for ladder samples results in
failed analysis.

Injections containing the allelic ladder must be analyzed with the same analysis
method and parameter values that are used for samples, to ensure proper allele
calling.

Alleles that are not in the AmpF(STR™ Allelic Ladders do exist. Off-ladder (OL)
alleles may contain full and/or partial repeat units. An off-ladder allele is an allele
that occurs outside the +0.5-nt bin window of any known allelic ladder allele or
virtual bin.

Note: If a sample allele peak is called as an off-ladder allele, verify the sample
result according to your laboratory’s protocol.

Set up GeneMapper™ ID Software for data analysis

File names

Overview

34

The file names shown in this section may differ from the file names you see when you
download or import files. If you need help determining the correct files to use, contact
your local Life Technologies Human Identification representative, or go to
www.appliedbiosystems.com.

To analyze sample (.fsa) files using GeneMapper'" ID Software v3.2.1 for the first time:

1.

Import panels and bins into the Panel Manager, as explained in “Import panels
and bins” on page 35.

Create an analysis method, as explained in “Create an analysis method” on
page 38.

Create a size standard, as explained in “Create a size standard” on page 42.

Define custom views of analysis tables.
Refer to the GeneMapper™ ID Software Versions 3.1 and 3.2 Human Identification
Analysis Tutorial (Part no. 4335523) for more information.

Define custom views of plots.
Refer to the GeneMapper™ ID Software Versions 3.1 and 3.2 Human Identification
Analysis Tutorial (Part no. 4335523) for more information.
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Section 4.1 GeneMapper™ ID Software
Set up GeneMapper™ ID Software for data analysis

Import panels and  To import the NGM " Kit panel and bin set from www.appliedbiosystems.com into
bins the GeneMapper'" ID Software v3.2.1 database:

1. Download and open the file containing panels and bins:

a. From the Support menu of www.appliedbiosystems.com, select

Support » Software Downloads, Patches & Updates » GeneMapper" ID
Software v 3.2 » Updates & Patches, and download the file NGM Analysis
Files GMID.

b. Unzip the file.

2. Start the GeneMapper'" ID Software, then log in with the appropriate user name
and password.

IMPORTANT! For logon instructions, refer to the GeneMapper™ ID Software
Version 3.1 Human ldentification Analysis User Guide (Part no. 4338775).

3. Select Tools » Panel Manager.

4. Find, then open the folder containing the panels, bins, and marker stutter:

a. Select Panel Manager in the navigation pane.

. (¥ Panel Manager
b. Select File » Import Panels to open the Import Fle Edt Bins View

Panels dialog box. ;
anels dialog box B || W ||

== Panel Manager

c. Navigate to, then open the NGM Analysis Files
GMID folder that you unzipped in step 1 above.

5. Select NGM_panel_v2.txt, then click Import.

Note: Importing this file creates a new folder in the navigation pane of the Panel
Manager, AmpFLSTR_NGM_v2. This folder contains the panel and associated
markers.

(@) Import Panels |

Lookin: | NGM Analysis Files GMD =l £F

File name: INGMJJaneI_th:d Import |
tly Documents [ STEEee type: IA" Files LI cancel |

6. Import NGM_bins_v2.txt:
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Chapter 4 Data Analysis

Set up GeneMapper™ ID Software for data
analysis

a. Select the AmpFLSTR_NGM._v2 folder in the navigation pane.

Panel Manager
File Edit Bins ‘fiew

“=F><|||I|III|II||..||BinSet:I L||||||[gm||

[E+EdPanel Manager Pamel Hame [ obttert
[T ampFLSTR_Panelz_v1 1 NGM_panel_w2 | o

b. Select File » Import Bin Set to open the Import Bin Set dialog box.
c. Navigate to, then open the NGM Analysis Files GMID folder.
d. Select NGM_bins_v2.txt, then click Import.

Note: Importing this file associates the bin set with the panels in the
NGM_panel_v2 folder.

mport Bin Set il

Lockin: | NGM analysis Files GMID =l ek E

NGM_panel_v2

File: name: INGM_binS_vQ.txt Irmport |
Files of type: IA" Files LI Cancel |

7. View the imported panels in the navigation pane:

a. Double-click the AmpFLSTR_NGM_v2 folder to view the NGM_panel_v2
folder.

b. Double-click the NGM_panel_v2 folder to display the panel information in
the right pane.

Panel Manager

Edit Bins View

|8 | W msefore: <[5 85 (R
- =IPanel Manager Dfarboer Harme Inee Color | Dfin Size M.ax?ne Coritrol Alleles Dfarbeer F | Doflardoer ? | Copronents Ladder Alleles
mAmpFLSTR_Panels_w 1 piosizas |bie 720 (1270 [M215 4 01239 [none 83,1011,12,13,14,1516,17
E-ES AmpFLETR_NGM 2[5 [waa, blue 1490 [2143 |48 4 01183 |none 11,1213,14,1516,17 18,19,
L OS2 3 |DiEssag blue 2236 2776|900 4 04012 [none 559,10,11,12,1314,15
Y 4 |D2s1338 blue 2616  |3560  |"20,23" 4 01283 none 15,16,17,18,19,20,21 22,23,
—D165539 5 |AMEL green 1000 [1080  ["ey" [ 00 |none w0
—D2s133s 6 |DES1179 green (1178 1748 |23 4 01031 |nane 59,1011,1213,14151617
:2;'1:1"1?9 7 |D21511 green 1768  |2498  |"2831" 4 01087 |none 2424 2,25 26,27 28,26 2,29
| p21s1t 5 |D1&sst green  |2595  |3475 M2 4 0.1408 |none 781010211,1213,13.2,1¢
—D18551 9 |D2251045 yellow  [76.0  [1200  ["1118" 3 01805 |none 83,1011,12,13,14,1516,17
02251045 10 |D195433 yellow 1223 1663 |“14,15" 4 0112 |none 91011,1212.21313.2,14,
:?;318433 19 |THO yellow 1764 (2211 733 4 0.0427 [none 456,789931011,133
| Foa 12 [FGa yellow 2216|3720 ["24,26" 4 0121 |none 17,18,19,20,21 22,23 24 25,
—D25441 13 [D25441 red 745 1134|415 4 0.0945 |none 210,11,11.312,13,1415,16
—DEs13ss 14 0331358 red 1144 1624 ["516" 4 01307 |nane 121314151617 16,19
:313;2:18 15 151656 red 1700|2240 |38 4 01446 none 910,11,12,13,14 1431515
16 |D12539 red 2250|2870 |19 4 01527 |none 14,15,16,17,16,19,19.3,20,2
—=JReference Samples
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8. Select D10S1248 to display the Bin view for the marker in the right pane.

Section 4.1 GeneMapper™ ID Software
Set up GeneMapper™ ID Software for data analysis

(¥ Panel Manager

File Edit Bins View

B3| 61 0|0 e v || | [

[E-EIPanel Manager
] &mpFLSTR_Panels_v1
EHES AmpFLETR_MGM_v2

[ VA,
—D1BS539
—D2s1338
[~ AMEL
—Das117a
—D21s1
—D18s51
[—D22s1045
—D195433
— THO1
—FGA
[—D2s441
—D3s1358
—D1S1656
D253

—SIReference Samples

N kil 75 9 &3 87 9 a5 99 103 107 1 118 Rkl 123

127

D1051248

13

b
|

ok Cancel Apply

9. Click Apply, then OK to add the NGM"" Kit panel and bin set to the
GeneMapper' " ID Software database.

IMPORTANT! If you close the Panel Manager without clicking OK, the panels

and bins are not imported into the GeneMapper'" ID Software database.
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Create an analysis

method

General tab

settings

38

Use the following procedure to create an HID analysis method for the
AmpF(STR™ NGM ™ Kit.

1.

Select Tools » GeneMapper Manager to open the GeneMapper Manager.

[#)GeneMapper Manager =
Projects Analysis Methods | Table Settings | Piot Settings | Matrices | Size Standards |
[Marne Last Saved ner Instrurment Analysis Type Descrip
HID_Advanced 2009-06-15 16:22:2 | amid HID =
HID_Clazsic 2007-05-06 10:03:0 | amic HID
Microsatelite Default 2004-05-28 11:34:3 | amid Microsatellite Factory
I .

Iy Cpen... Save Az Inport... Expaort... Delete |
Done |

2. Select the Analysis Methods tab, then click New to open the New Analysis
Method dialog box.
3. Select HID and click OK to open the Analysis Method Editor with the General tab
selected.
Enter the settings shown in the figures on the following pages.
4. After you enter settings in all tabs, click Save.
x

General | lele | Pesk Detector | Peak Qualty | Gualty Fiags |

&nalysis Method Description
[arne: MGM_AnalysisMethod_v2

Description:

Instrument: I

Analysis Type: HID

L LIv|

OK | Cancel |

In the Name field, either type the name as shown for consistency with files

supplied with other AmpF(STR™ kits, or enter a name of your choosing. The
Description and Instrument fields are optional.
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Section 4.1 GeneMapper™ ID Software

Set up GeneMapper™ ID Software for data analysis

Allele tab settings Analysts Method Editor - HID x|
General Peak Detector I Peak Guality I Guality Flags I
BinSet  [NGM_bins_v2 =l
V Use marker-specific stutter ratio if available
Marker Repest Type : Tri Tetra Perta Hexa
Cut-off Yalue 0.0 0.0 0.0 0.0
dinus4 Ratio 0.0 0.0 0.0 0.0
Minuza, Distance Fram 0.0 0.0 0.0 0.0
To 00O 0.0 0.0 0.0
Minuz Stutter Ratio 0.0 0.0 0.0 0.0
Minuz Stutter Distance Fram |2.25 3.25 0.0 0.0
Ta 375 4.75 0.0 0.0
Pluzs Stutter Ratio 0.0763 0.0 0.0 0.0
Fluz Stutter Distance Fram |2.25 0.0 0.0 0.0
Ta 375 0.0 0.0 0.0
Amelogenin Cutoff Ig_g

Range Fitter ... | Factory Defaults |
OK | Cancel |

* In the Bin Set field, select the NGM_bins_v2 bin set imported previously and
configure the stutter distance parameters as shown.

* GeneMapper" ID Software v3.2.1 allows you to specify four types of marker
repeat motifs: tri, tetra, penta, and hexa. You can enter parameter values for each
type of repeat in the appropriate column.

* The “Use marker-specific stutter ratio if available” check box is selected by
default. Consequently, the software applies the stutter ratio filters supplied in the
NGM_panel_v2 file. GeneMapper'" ID Software v3.2.1 specifies locus-specific
filter ratios for minus stutters, but not for plus stutters, in the panel file. However,
validation studies with the NGM" Kit show that the trinucleotide repeat
D2251045 locus produces a relatively large amount of plus stutter compared to
tetranucleotide repeat loci. The relatively large amount of stutter may cause the
stutter peak to be labeled during routine analysis.

* The plus stutter at the D2251045 locus can be filtered by assigning a global plus
stutter filter for trinucleotide repeat loci in the Analysis Parameter file. Because
D2251045 is the only trinucleotide repeat locus in the NGM™ Kit, this stutter filter
setting is applied only to plus stutter peaks at the D2251045 locus. The settings
shown above resulted in little or no labeling of D2251045 plus stutter peaks
during our validation studies. Perform internal validation studies to determine
the settings to use in your laboratory.
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settings
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Chapter 4 Data Analysis
Set up GeneMapper™ ID Software for data analysis

Analysis Method Editor - HID

General | Alele Peak Detector | peak dualiy | Guaity Flags |

Peak Detection Algarithn: I.&.dvanced 7 I

~Ranges
Aralysis Sizing
Full Range | Jensizes x|
Start Btz [0 Start Size0
Stop Pt [10000 Stop sizesf1000 |

—=moothing ahd Baselining

X
Peak Detection
ﬁak Ampltude Thresholds:
B: | R |
G: | 0: |
e
Min. Pesk Half Wyicth: 2 pts

Stnoothing = None
& Light Palyhomial Degree: K
™ Heawy Peak window Size: |1 5 pts
Bazeling Window: IS'I pts Slope Threshold
Peak Start: 0.0
~Size Calling Method Pesak End: o0
" 2nd Order Least Squares
o E
' Cubic Spling Interpolation
~ Local Southern Method
" Global Southern Methad
Factary Defaults |
Ok | Catcel |

Perform
internal
validation
studies to
determine
settings

IMPORTANT! Perform the appropriate internal validation studies to determine the
peak amplitude thresholds for interpretation of NGM " Kit data.

Fields include:

* Peak amplitude thresholds — The software uses these parameters to specify the
minimum peak height, in order to limit the number of detected peaks. Although
GeneMapper " ID Software displays peaks that fall below the specified amplitude
in electropherograms, the software does not label or determine the genotype of

these peaks.

* Size calling method - The NGM" Kit has been validated using the 3'4 Order
Least Squares sizing method in combination with the GeneScan"" 500 LIZ"™ Size
Standard. If using the GeneScan'" 600 LIZ"™ Size Standard v2.0, select the Local
Southern Method. Select alternative sizing methods only after you perform the

appropriate internal validation studies.
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Peak Quality tab

. Analysis Method Editor - HID x|
settings ceneral| aliele | Peak Detector  Peak Qualty | Guaity Flags |
gignal lenel
Perform
Homozygous min peak height internal
Heterozygous min peak height validation
studies to
rHeterozygote balance determine
in peak height ratio settings

~Pesk morphology

Wax peak width (hasepairs) ]
~Pull-up peak
Pull-up ratio s

—&llele number

Max expected alleles

i N

Factary Defautts |

0K | Carcel |

IMPORTANT! Perform the appropriate internal validation studies to determine the

heterozygous and homozygous minimum peak height thresholds and the minimum
peak height ratio threshold that allow for reliable interpretation of NGM ™" Kit data.
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Quality Flags tab Analysis Method Editor - HID x|
settings General | Allste | Pesk Detector | Peak Guaity Gualty Flags |
Quality weight= are between 0 and 1.
—Gwalty Flag Settings
Spectral Pull-ug ID_E Control Concordance I‘I n
Eroad Peak ID_E Lowy Peak Height ID.S
Out of Bin Allsle o5 ©Off-scale |U-3
Overlap Ig_g Peak Height Ratio ID.S
PN Threshalds
Pazs Range: Lovwy Giuality Range:
Sizing Quality: Fram ID.?S to1.0 From 0.0 {0 ID.25
Genatype Guality: From |0.75 to1.0 From 00to  |0.25
Factary Defaultts |
Ok | Cancel |
IMPORTANT! The values shown are the software defaults and are the values we used
during developmental validation. Perform the appropriate internal validation studies
to determine the appropriate values to use in your laboratory.
Create a size The size standards for the NGM"" Kit uses the following size standard peaks in their
Standa rd definitions:

GeneScan™ 500 LIZ™ Size Standard GeneScan™ 600 LIZ™ Size Standard v2.0

75,100, 139, 150, 160, 200, 300, 350, 400, and | 80, 100, 114, 120, 140, 160, 180, 200, 214, 220,
450 240, 250, 260, 280, 300, 314, 320, 340, 360,
380, 400, 414, 420, 440 and 460

Note: The 250-nt and the 340-nt peak are not included in the size standard definition.
These peaks can be used as an indicator of precision within a run.

Use the following procedure to create the size standard for the NGM " Kit.
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Section 4.1 GeneMapper™ ID Software

Analyze and edit sample files with GeneMapper™ ID Software

1. Select Tools » GeneMapper Manager to open the GeneMapper Manager.
x

Projects | Analysis Methods | Table Settings | Pict Settings | Matrices

|Name |Last Saved |Owner Y |Descripti0n

377 _F_HID_GS500 2004-05-28 11:34:3 | graicd Basiciidvanced Factory Provided | *

CE_G5_HD_GS500 2004-05-25 11:34:3 | grnicd Basicidvanced Factory Provided

CE_F_HID_GS500 2004-05-28 11:34:3 | gmid Easiciidvanced Factory Provided -
(L GREf. Save e

Ittt ... Export... Delete |

Done | |

2. Select the Size Standards tab, then click New.

3. Enter a name as shown below or enter a name of your choosing. In the Size
Standard Dye field, select Orange. In the Size Standard Table, enter the sizes
specified in on page 42. The example below is for the GeneScan™" 500 LIZ™ Size

Standard.

[#)size standard Editor

Edit

~Size Standard Description

Marme:

Description:

Size Standard Oye:

CE_G5_NGM_GS500

IOrangs

[-Size Standard Tabl

Size in Basepairs

50

1000

135.0

150.0

200.0

1

2

3

4

5 1600
B

7 (3000
g

3500

la |sonn

10 (4500

DK | Cancel |

Analyze and edit sample files with GeneMapper™ ID Software

1. In the Project window, select File » Add Samples to Project, then navigate to the
disk or directory containing the sample files.

2. Apply analysis settings to the samples in the project. The names of the settings
shown are the names suggested in the sections above.

Parameter

Settings

Sample Type

Select the sample type.

Analysis Method

NGM_AnalysisMethod_v2 (or the name of the analysis method you

created)

Panel

NGM_panel_v2

Size Standard

CE_G5_NGM_GS500 (or the name of the size standard you created)
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Examine and edit a project

For more information about how the Size Caller works, refer to the ABI Prism™

GeneScan'" Analysis Software for the Windows NT'" Operating System Overview
of the Analysis Parameters and Size Caller User Bulletin (Part no. 4335617). For

additional information about size standards, refer to the GeneMapper'" ID
Software Version 3.1 Human Identification Analysis User Guide (Part no. 4338775).

3. Click I» (Analyze), enter a name for the project (in the Save Project dialog box),
then click OK to start analysis.
¢ The status bar displays the progress of analysis as both:

— A completion bar extending to the right with the percentage completed
indicated

— With text messages on the left

* The table displays the row of the sample currently being analyzed in green
(or red if analysis failed for the sample).

¢ The Genotypes tab becomes available after analysis.

(7)GeneMapper ID ¥3.2.1 - NGM Population Data - gmid Is Logged In ] ] 3
File Edt Analysis View Tools Help
& = @1”5 ?ﬂ”ﬁﬂ.ﬂ] ]_|_|H|ﬂ £ H & HTahlaSellinngH\DTab\e LImH@ é”m
E-SProject Samples | Genotypes |
(-T2008-01-20 Stetus [Sample File Sawmple Name  |Sample Type | Analysis Method Panel [Size Standard Runbame [Instrumert Type ||
1 W | Cerebus_012008 (10001 Sample NGM_AnalysisMethod_v2 | NGM_panel 2 CE_G5_NGM_GS500 | 2009-01-20_C| ABI3130 8
2 W |Cerebus_012008 [5_0002 Sample NGM_AnalysisMethod_v2 | NGM_panel 2 CE_G5_NGM_GS500 | 2009-01-20_C | ABI3130
3 W |Cerebus_012008 [5_0003 Sample NGM_AnalysisMethod_v2 | NGM_panel 2 CE_G5_NGM_GS500 | 2009-01-20_C | ABI3130
n W |Cerebus_012008 [I5_0004 Sample NGM_AnalysisMethod_v2 | NGM_panel 2 CE_G5_NGM_GS500 | 2009-01-20_C | ABI3130
5 W |Cerebus_012008 [5_000S Sample NGM_AnalysisMethod_v2 | NGM_panel 2 CE_G5_NGM_GS500 | 2009-01-20_C | ABI3130
5 W | Cerebus_012008 [5_0005 Sample NGM_AnalysisMethod_v2 | NGM_panel 2 CE_G5_NGM_GS500 | 2009-01-20_C | ABI3130
7 W |Cerebus_012008 [B_0007 Sample NGM_AnalysisMethod_v2 | NGM_panel 2 CE_G5_NGM_GS500 | 2009-01-20_C | ABI3130
a W | Cerebus_012008 [I5_0005 Sample NGM_AnalysisMethod_v2 | NGM_panel 2 CE_G5_NGM_GS500 | 2009-01-20_C | ABI3130
9 W | Cerebus_012008 [5_0003 Sample NGM_AnalysisMethod_v2 | NGM_panel 2 CE_G5_NGM_GS500 | 2009-01-20_C | ABI3130
10 W |Cerebus_012008 [B_0010 Sample NGM_AnalysisMethod_v2 | NGM_panel 2 CE_G5_NGM_GS500 | 2009-01-20_C | ABI3130
11 W | Cerebus_012008 (160011 Sample NGM_AnalysisMethod_v2 | NGM_panel 2 CE_G5_NGM_GS500 | 2009-01-20_C | ABI3130
12 W |Cerebus_012008 |5 0012 Sample NGM_AnalysisMethod_v2 | NGM_panel 2 CE_G5_NGM_GS500 | 2009-01-20_C | ABI3130
13 W |Cerebus_012008 [B_0013 Sample NGM_AnalysisMethod_v2 | NGM_panel 2 CE_G5_NGM_GS500 | 2009-01-20_C | ABI3130
14 W |Cerebus_012008 |5 00T+ Sample NGM_AnalysisMethod_v2 | NGM_panel 2 CE_G5_NGM_GS500 | 2009-01-20_C | ABI3130
15 W | Cerebus 012008 [Lacdert Alelic Lacider | NGM_A&nalysisMethod_w2 | NG _panel_v2 CE_G5_NGM_GS500 | 2009-01-20_C | ABI3130
al |
KT 1
Progress Status I i

Examine and edit a project

You can display electropherogram plots from the Samples and Genotypes tabs of the
Project window to examine the data. These procedures start with the Samples tab of
the Project window (assuming the analysis is complete).

For more information

For details about GeneMapper'" ID Software features, allele filters, peak
detection algorithms, and project editing, refer to:

o GeneMapper™ ID Software Versions 3.1 and 3.2 Human Identification Analysis Tutorial
(Part no. 4335523)

o GeneMapper™ ID Software Version 3.1 Human Identification Analysis User Guide (Part
no. 4338775)

e Installation Procedures and New Features for GeneMapper™ ID Software Software
Version v3.2 User Bulletin (Part no. 4352543)
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Chapter 4 GeneMapper™ ID-X Software

Overview of GeneMapper™ ID-X Software

Section 4.2 GeneMapper™ ID-X Software

Overview of GeneMapper™ ID-X Software

GeneMapper " ID-X Software is an automated genotyping software for forensic
casework, databasing, and paternity data analysis.

After electrophoresis, the data collection software stores information for each sample

in a .fsa file. Using GeneMapper " ID-X Software v1.0.1 or higher you can then
analyze and interpret the data from the .fsa or .hid files.

Note: .hid files can only be analyzed using GeneMapper"" ID-X Software v1.2 or

higher

Instruments Refer to “Instrument and software overview” on page 16 for a list of compatible
instruments.

Before you start When using GeneMapper'" ID-X Software v1.0.1 or higher to perform human

identification (HID) analysis with AmpF(STR"" kits, be aware that:

e HID analysis requires at least one allelic ladder sample per run folder. Perform
the appropriate internal validation studies if you want to use multiple ladder
samples in an analysis.

For multiple ladder samples, the GeneMapper" ID-X Software calculates allelic
bin offsets by using an average of all ladders that use the same panel within a run
folder.

¢ Allelic ladder samples in an individual run folder are considered to be from a
single run.
When the software imports multiple run folders into a project, only the ladder(s)
within their respective run folders are used for calculating allelic bin offsets and
subsequent genotyping.

¢ Allelic ladder samples must be labeled as “Allelic Ladder” in the Sample Type
column in a project. Failure to apply this setting for ladder samples results in
failed analysis.

¢ Injections containing the allelic ladder must be analyzed with the same analysis
method and parameter values that are used for samples to ensure proper allele
calling.

* Alleles that are not in the AmpF(STR™ Allelic Ladders do exist. Off-ladder (OL)
alleles may contain full and/or partial repeat units. An off-ladder allele is an allele
that occurs outside the +0.5-nt bin window of any known allelic ladder allele or
virtual bin.

Note: If a sample allele peak is called as an off-ladder allele, verify the sample
result according to your laboratory protocol.
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Set up GeneMapper™ ID-X Software for data analysis

File names The file names shown in this section may differ from the file names you see when you
download or import files. If you need help determining the correct files to use, contact
your local Life Technologies Human Identification representative, or go to
www.appliedbiosystems.com.

Overview To analyze sample (.fsa) files using GeneMapper'" ID-X Software v1.0.1 or higher for
the first time:

1. Import panels, bins, and marker stutter into the Panel Manager, as explained in
“Import panels, bins, and marker stutter” below.
2. Create an analysis method, as explained in “Create an analysis method” on page
50.
3. Create a size standard, as explained in “Create a size standard” on page 55.
4. Define custom views of analysis tables.
Refer to the GeneMapper™ ID-X Software Version 1.0 Getting Started Guide
(Part no. 4375574) for more information.
5. Define custom views of plots.
Refer to the GeneMapper™ ID-X Software Version 1.0 Getting Started Guide
(Part no. 4375574) for more information.
Import panels, To import the NGM " Kit panels, bin sets, and marker stutter from the Applied
bins, and marker Biosystems web site into the GeneMapper'" ID-X Software database:
stutter 1. Download and open the file containing panels, bins, and marker stutter:
a. From the Support menu of www.appliedbiosystems.com, select
Support » Software Downloads, Patches & Updates » GeneMapper' " ID-X
Software » Updates & Patches, and download the file NGM Analysis Files
GMIDX.
b. Unzip the file.
2. Start the GeneMapper " ID-X Software, then log in with the appropriate user
name and password.
IMPORTANT! For logon instructions, refer to the GeneMapper'" ID-X
Software Version 1.0 Getting Started Guide (Part no. 4375574).
3. Select Tools » Panel Manager.
4. Find, then open the folder containing the panels, bins, and marker stutter:

46

a. Select Panel Manager in the navigation pane.

b. Select File » Import Panels to open the Import wh,Panel Manager

Panels dialog box fle Edt Bns Wiew Help
c. Navigate to, then open the NGM Analysis Files - - - __
GMIDX folder that you unzipped in step 1 of this [| * ESEIEEIEES

section.
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Section 4.2 GeneMapper™ ID-X Software
Set up GeneMapper™ ID-X Software for data analysis

5. Select NGM_panel_v2X, then click Import.

Note: Importing this file creates a new folder in the navigation pane of the Panel
Manager “AmpFLSTR_NGM_v2X". This folder contains the panel and associated
markers.

#* Import Panels

Lookin: | () NGM Analysis Files GMIDX v 2EE
] [£] NGM_hins_vZ¥.txk
| Bl NGM_panal_vZ.bxt
My Recent [Z] NGM_stutter_v2.kxt
Documents
Desktop
¥ &
My Documents | File name: |NGMJaneI_\r2X.txt | [ Impaort ]

'S [. Files of type: |AII Files v| Cancel

6. Import NGM_bins_v2X.txt:
a. Select the AmpFLSTR_NGM_v2X folder in the navigation pane.

»* Panel Manager
File Edit Bins View Help

WX | B O | M | ense v|

B...d%‘]pand Manager Pariel Hirme | Conrirert
[ i ArnpFLSTR._NGM_ vz 1 MGM_panel vz |nu||

[ I-5) AmpFLSTR_Panels_v1x

b. Select File » Import Bin Set to open the Import Bin Set dialog box.
c. Navigate to, then open the NGM Analysis Files GMIDX folder.
d. Select NGM_bins_v2X.txt, then click Import.

Note: Importing this file associates the bin set with the panels in the
NGM_panel_v2X folder.

»* Import Bin Set

Lookin: | () NGM Analysis Files GMIDX v o EE
;EB E] MGM_panel_v2 kxt
My Recenk =| MGM_stutker w2 bxt
Documents
Desktop
8 S
My Documents | File name: |NGM_bins_v2X.txt | ’ Import l

ﬁ A Files of bype: |AII Files v | Cancel

7. View the imported panels in the navigation pane:
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a. Double-click the AmpFLSTR_NGM_v2X folder.

b. Double-click the NGM_panel_v2X folder to display the panel information in
the right pane and the markers below it.

»* Panel Manager

File Edit Bins View Help

Wi X | BF MO W™ | nse: [No bins vax v MLGEE SEEEEEEN
- g, Panel Manager |Miker Mame  |Dye Color | Min Size | B Size | Conrol Alleles Matker | Commmts Ladder Alleles
I AmpFLSTR_NGM_v2x | |1 [PTusizas Blue  |720 1270 |12,15 4 nane 8,9,10,11,12,13,14,15,16,17,18
= [oNGM_panel vz 7 |vWh Bue 149.0 (2143 14,16 4 none 11,12,13,14,15,16,17,18,19,20,21,22,2:
E:vons124s 3 |D163539 Blue  |223.6 |277.6  |3,10 4 none 5.8,9,10,11,12,13,14,15
D165539 4 |Desi33s Blue  |28L.6  |356.0  |20,23 4 nons 15,16,17, 18,19,20,21,22,23,24,25,26, 2:
D251338 5 |AMEL Green 100.0 103.0 A 9 none A
AMEL 6 |Das1179 Green (1178 (1749 12,13 4 nane 8,9,10,11,12,13,14,15,16,17,15,19
ggf;fg 7 D231t Green  |176.8  |249.8  |28,3l 4 none 24,24.2,25,26,27,28,28.2,29,29.2,30,30
D18s51 & |D18%51 Green  |259.5  |347.5  |12,15 4 none 7,9,10,10,2,11,12,13,13.2,14,14.2,15, 1
D2251045 9 |D223i045 Yellow |76.0 12000 |11,16 3 none 8,9,10,11,12,13,14,15,16,17,15,19
D195433 10 |D195433 vellow (1223 |166.3  |14,15 4 none 9,10,11,12,12.2,13,13.2,14, 14.2, 15,15,
;::l 11 |THOL Yellow  |176.4  |221.1  |7,9.3 4 none 4,5,6,7,8,9,9.3,10,11,13.3
e 12 |FGA Yellow |221.6  |372.0  |24,26 4 none 17,18,19,20,21,22,23,24,75,26,26.2,27,
D351358 13 |D25441 Red 745 |113.4  |14,15 4 nons 9,10,11,11.3,12,13,14,15,16
D151856 14 |D351358 Red 114.4 |168.4 15,16 4 naone 12,13,14,15,16,17,15,19
E}-@ADIE)LIS%FSRS_S‘;aneIs_\rIX 15 |D151656 Red 170.0 2240 (13,16 4 none 9,10,11,12,13,14,14.3,15,15.3, 16, 16,3,
16 |D125331 Red 2250  |287.0  |18,19 4 none 14,15,16,17,18,19,19.3,20, 21,22,23,24,
------ 45, Reference Samples |

8. Select D10S1248 to display the Bin view for the marker in the right pane.

#* Panel Manager

File Edit Bins WView Help
B3 | B B M| B WY | BinSet: NGM_bins_vax v fLELE SEEEEENE o
= g3y Panel Manager
i E_)nmpFLSTR_NGM_\rZX . 7 5 Q 10 11 12 13 14 15 16 17 18 19 20
E-ICHNGM_panel_v2X
210
VWA 0a
- D165539
- D251338 0s
- AMEL
-D851179
-D21511 055
- D18551
- D2251045 0.6
- 0195433
- THOL
- FGA 03
- D25441
- D351358 -
-D151656
[ D125391
- IC3) AmpFLSTR _Panels_v1x =3
. 0z
------ B Reference Samples
o4
on
BF B9 71 T2 TS YT TS @1 83 85 87 83 91 93 495 97 83 01 102 103 107 108 111 112 115 17 119 121 123 125 127 129 13
L1051242
< 3
[ oK H Cancel H Apply H Help ]

9. Import NGM_stutter_v2X.txt:
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Select the AmpFLSTR_NGM_v2 folder in the navigation panel.

#* Panel Manager
File Edit Bins VWew Help

w > W E W ™ | Binset: |NGM_bins_vzZx v

=) gZy Panel Manager Panel Hame Commert
=8 (Wi AmpFLSTR_NGM_v2X] 1 [NGM_panel_vZx null
- ICAMpFLSTR_Panels_w1x

. Select File » Import Marker Stutter to open the Import Marker Stutter dialog

box.

Navigate to, then open the NGM Analysis Files GMIDX folder.

. Select NGM_stutter_v2X.txt, then click Import.

Note: Importing this file associates the marker stutter ratio with the bin set
in the NGM_bins_v2X folder.

#* Import Marker Stutter

Loakin: |E:| NGM Analysis Filas GMIDX v | T EE
Ty [Z] MEM_bins_va.bxt
§ b [Z] NGM_panel_vZx bxt

My Recenk
Documents

@
Desktop

9

@

My Documents File name: |NGM_stutter_\r2X.t><t | [ Import ]

- Files of type: .
la lles of type: | All Files | Cancel

10. View the imported marker stutters in the navigation pane:

a.

Select the NGM_panel_v2X folder to display its list of markers in the right
pane.

. Double-click the NGM_panel_v2X folder to display its list of markers below

it.

Double-click D2251045 to display the Stutter Ratio & Distance view for the
marker in the right pane.

AmpFISTR™NGM™ PCR Amplification Kit User Guide 49



Chapter 4 GeneMapper™ ID-X Software
Set up GeneMapper™ ID-X Software for data analysis

4

Because D2251045 has a trinucleotide repeat unit, it produces a higher level
of plus stutter than tetranucleotide markers, and so requires the use of a plus
stutter filter. The settings for the D2251045 plus stutter filter can be seen in
the table in the right pane. Other markers may not require a plus stutter
filter, in which case the settings for plus stutter are left blank.

« Panel Manager.

File Edit Bins View Help
X W WM W™ enser [vanbis v v #fLERE BEEEEEENE o
(= [ AmpFLS TR, _MGM 2 = ) ) ) )
E-ENGM_panel_v2x Please enter the stutter filter(s) for 02251045 marker here If left blank, the global stutter filter will be applied.
- D1051248
Minus Stutter Plus Stutter
-- 0251338 R.atio From Distance To Distance Ratio From Distance To Distance
-- AMEL il 1805 2.25 3.75 1 0763 2.25 3.75
-- 0351179 2 2
-- D21511
- D18551 2 :
E} 02251045 4 4
1 Stutter Ratio & Distance [ = H Edit H e ]
- THO1
-- Fizh
-- 025441 =
-- 0351358
--D151656
[ 125391 -
4 |
[ OF H Cancel H Apply H Help ]
. ™ . .
11. Click Apply, then OK to add the NGM ™ Kit panels, bin sets, and marker stutter

to the GeneMapper'" ID-X Software database.

IMPORTANT! If you close the Panel Manager without clicking Apply, the
panels, bin sets, and marker stutter will not be imported into the GeneMapper"
ID-X Software database.

Create an analysis  Use the following procedure to create an analysis method for the NGM™ Kit.

method
IMPORTANT! Analysis methods are version-specific, so you must create an analysis
method for each version of the software. For example, an analysis method created
for GeneMapper " ID-X Software version 1.2 is not compatible with earlier versions
of GeneMapper™ ID-X Software, or with GeneMapper'" ID Software version 3.2.1.
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1. Select Tools » GeneMapper™" ID-X Manager to open the

GeneMapper " ID-X Manager.

Find Mame Containing: |

Prajects | Analysis Methods | Table Settings | Plok Settings | Matrices | Size Standards | Repart Settings

Marne Last Saved Cuner Instrument Analysis Type C
| AmpFLSTR_AnalysisMethod _w1x 2011-02-25 09:43:0 | grid: HID |1
< | 0|

2. Select the Analysis Methods tab, then click New to open the Analysis Method

Editor with the General tab selected.

3. Enter the settings shown in the figures on the following pages.

Note: The Analysis Method Editor closes when you save your settings (see step 4
on page 51). To complete this step quickly, do not save the analysis method until

you finish entering settings in all of the tabs.

4. After you enter the settings on all tabs, click Save.

General tab
settings

Analysis Method Editor

i General | Allele || Peak Detector | Peak Quality | SQ & GQ Settings

~Analysis Method Description
Name: MGM_AnalysisMethod_vZ}
Security Group: GeneMapper ID-X Security Group
Description: ~
4
Instrument:
Analysis Type: HID

Save As H Save H Cancel H Help ]
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Allele tab settings

52

In the Name field, either type the name as shown for consistency with files supplied
with other AmpF(STR™ kits or enter a name of your choosing. In the Security Group
field, select the Security Group appropriate to your software configuration from the
drop-down list. The Description and Instrument fields are optional.

Analysis Method Editor

| Generall Allele | Peak Detector || Peak Quality || SQBGQ Settings|

Bin Sek:
Use marker-specific stutter ratio and distance if available

Marker Repeat Type: Tri Tetra Penta Hexa

Global Cut-off Value 0.0 0.0 0.0 0.0

MinusA R.atio 0.0 0.0 0.0 0.0

MinusA Distance From |0.0 0.0 0.0 0.0
To (0.0 0.0 0.0 0.0

Global Minus Stutker Ratio 0.0 0.0 0.0 0.0

Global Minus Stutter Distance  From 2,25 3.25 0.0 0.0
To |3.75 4.75 0.0 0.0

Global Plus Stutter Ratio 0.0 0.0 0.0 0.0

Global Plus Stutter Distance From (0.0 0.0 0.0 0.0
To (0.0 0.0 0.0 0.0

Amelogenin Cutoff

Range Filter. .. Factory Defaults

[ Save As H Save H Cancel H Help ]

* In the Bin Set field, select the NGM_bins_v2X bin set imported previously and
configure the stutter distance parameters as shown.

» GeneMapper " ID-X Software allows you to specify 4 types of marker repeat
motifs: tri, tetra, penta, and hexa. You can enter parameter values for each type of
repeat in the appropriate column.

¢ The “Use marker-specific stutter ratio if applicable” check box is selected by
default. When this box is checked, the software applies the stutter ratio filters in
the NGM_stutter_v2X.txt file.
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General | Allsle | Peak Detector | Peak Quality | 5Q & GQ Settings

Peak Detection Algorithm: Advanced

(%) 3rd Order Least Squares
() Cubic Spline Interpolation
(O Local Southern Method
(O Global Southern Methad

MNormalization

[] use Mormalization, if applicable

Factory Defaults

Save As H Save H Cancel H Help ]

Ranges Peak Detection Perform
“”'YSis 5i2|:ﬂg Peak Amplituds Threshalds: internal
Full Range | | All Sizes . B l:l R l:l Valldatlon
G P: studies to
el e[ | determine
rSmoathing and Baselining Sett“’]gs
Min. Peak Half Width: |2 pts
Smoothing () None
@ Light Polynomial Degree: 3
(O Heavy Peak Window Size: 15 pts
" " Slope Threshold
Baseline Window: -51 pts
Peak Start: 0.0
rSize Calling Method Peak End: 0.0
(O 2nd Order Least Squares

IMPORTANT! Perform the appropriate internal validation studies to determine the
appropriate peak amplitude thresholds for interpretation of NGM ™ Kit data.

Fields include:

* Peak amplitude thresholds — The software uses these parameters to specify the
minimum peak height, in order to limit the number of detected peaks. Although
GeneMapper " ID-X Software displays peaks that fall below the specified
amplitude in electropherograms, the software does not label or determine the

genotype of these peaks.

Size calling method — The NGM™ Kit has been validated using the 34 Order
Least Squares sizing method with the GeneScan"" 500 LIZ™ Size Standard. If you
use GeneScan™ 600 LIZ™ Size Standard v2.0, select the Local Southern Method.
Select alternative sizing methods only after you perform the appropriate internal

validation studies.

Normalization (v1.2 or higher) — For use with 3500 data. Perform internal
validation studies to determine whether to use the Normalization feature for
analysis of NGM " Kit data.
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Peak Quality tab
Setti ngS Analysis Method Editor rz|

General | Allele | Peak Detector | Peak Qualty | 5q & 6Q Settings

Min/Max Peak Height (LPH/MPH)
Perform
internal
validation
studies to
determine
settings

Homozygous min peak height
Heterozygous min peak height

Max Peak Height (MPH)

Peak Height R.atio (PHR)
Min peak height: ratio

Broad Peak (BD)
Max peak width (basepairs)

Allele Number (AN

Max expected alleles

Allelic Ladder Spike

Spike Detection

SRR

Cut-off Value

=
P

Factory Defaults

Save As H Save H Cancel H Help ]

IMPORTANT! Perform the appropriate internal validation studies to determine the
heterozygous and homozygous minimum peak height thresholds, maximum peak
height threshold, and the minimum peak height ratio threshold for interpretation of
NGM"™ Kit data.
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settings

Create a size
standard
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Analysis Method Editor

General || Allele | Peak Detector | Peak Quality| 5Q 8 GQ Settings |

Quality weights are between 0 and 1.

Sizing Quality:

From to 1.0 From 0.0to |0.25
Genotype Quality:  From ko 1.0 From0.0k0 |0.25

rSample and Control GQ Weighting
Broad Peak (BD) Allele Number (AM)
Out of Bin Allele (BIN) Low Peak Height (LPH)
Qverlap (OWL) Max Peak Height (MPH)
Marker Spiks (SPK) OFf-scale (0S)

Peak Height Ratio (PHR)

Contraol Concardance (CC) Weight = 1.0 (Only applicable to controls)

50 Weighting
Broad Peak (BD)

rAllelic Ladder GQ Weighting
Spike (SSPK[SPK) OFf-scale (05)
5Q & GQ Ranges

| PassRange: [GHIOUSETRERGENN

Reset Defaults

Save As H Save H Cancel H Help ]

IMPORTANT! The values shown are the software defaults and are the values we used
during developmental validation. Perform appropriate internal validation studies to

determine the appropriate values to use.

The size standards for the NGM ™ Kit uses the following size standard peaks in their

definitions:

GeneScan™ 500 LIZ™ Size Standard

GeneScan™ 600 LIZ™ Size Standard v2.0

75, 100, 139, 150, 160, 200, 300, 350, 400, and
450

80, 100, 114, 120, 140, 160, 180, 200, 214, 220,
240, 250, 260, 280, 300, 314, 320, 340, 360,
380, 400, 414, 420, 440 and 460

Note: The 250-nt and the 340-nt peaks are not included in the size standard definition.
These peaks can be used as an indicator of precision within a run.

Use the following procedure to create the size standard for the NGM " Kit.

1. Select Tools » GeneMapper'" ID-X Manager to open the GeneMapper'" ID-X

Manager.
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2. Select the Size Standards tab, then click New.

Find Name Containing: ‘

| Projects | Analysis Methods || Table Settings | Plot Settings | Matrices| Size Standards | Repart Settings |

Marme Last Saved Chner Type Descripkion
| CE_F_HID_G3500 (75-400) 2007-08-09 13:23:5 | gmid: Advanced -~
| CE_F_HID_G3500 (75-450) 2007-08-09 13:24:0 | gmid: Advanced
| CE_G5_HID_GS500 2006-10-11 13:12:% | gmids Advanced @

3. Complete the Name field as shown below or with a name of your choosing. In the
Security Group field, select the Security Group appropriate to your software
configuration from the drop-down list. In the Size Standard Dye field, select
Orange. In the Size Standard Table, enter the sizes specified on page 55. The
example below is for the GeneScan™ 500 LIZ" Size Standard.

o Size Standard Editor
Edit

Size Standard Description

Mame: CE_G5_NGM_G5500

Security Group: GeneMapper [D-X Security Group
Description:

Size Standard Dye: Orange B |

Size Standard Table

1_ ngin Basepairs

2 |100.0

3 [139.0

4 (150.0

5 [160.0

& |200.0

7 |300.0

g8 (3500

9 [400.0

10 |450.0

’ QK ” Cancel H Help ]
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Analyze and edit sample files with GeneMapper™ ID-X Software

1. In the Project window, select File » Add Samples to Project, then navigate to the
disk or directory containing the sample files.

2. Apply analysis settings to the samples in the project. The names of the settings
shown are the names suggested in the sections above. If you named the settings
differently, select the names you specified.

Parameter Settings
Sample Type Select the sample type.
Analysis Method NGM_AnalysisMethod_v2X (or the name of the
analysis method you created)
Panel NGM_panel_v2X
Size Standard CE_G5_NGM_GS500 (or the name of the size

standard you created)

For more information about how the Size Caller works, or about size standards,
refer to the GeneMapper'" ID-X Software v1.2 Reference Guide (Part no. 4426481A).

3. Click I* (Analyze), enter a name for the project (in the Save Project dialog box),
then click OK to start analysis.

e The status bar displays the progress of analysis as a completion bar
extending to the right with the percentage completed indicated.

* The table displays the row of the sample currently being analyzed in green
(or red if analysis failed for the sample).

¢ The Analysis Summary tab is displayed upon completion of the analysis.

The figure below shows the analysis summary window after analysis.

» GeneMapper@ ID-X - NGM Analysis Example - gmidx Is Logged In Database FOSGREENRXLO4

Ele Edt Analyss Vew Tooks Admin Help

ol | W EHE W [E | » @  TableSettng: | |306DataAnalysis YA P8R De
-adn Project Samples | Analysis Summary | Genatypes|
D110217.1 l
Analysis Summary Summary Generation Date: Feb 25, 2011 10:33:37 AM
Select run Folder to display:
Semple Status Total # of Samples |
% Unanalyzed 0 |
Analyzed 18 |
' Analysis Setting Changed 0 |
Click a link below to display a fitered Samples Table containing only the samples selected
Allelic Ladder Quality per run folder (based on SQ and CGQ only)
Run Folder J[_Total # of Analyzed Ladders I I & ]
110217_Muligan_Ref_Plate19_31304... | 2 | 2 | o | o |

Control Quality per project (based on sample PQVs: SOS, SSPK, MIX, OMR, S0, CGQ)

Control Type Total # of Samples Allthresholds met @ One or more thrasholds not met ]
Positive Control 0 0 0
Custom Control 0 0 0
INegative Control 0 0 0
Total 0 0 0

Sample Quality per project (based on sample PQVs: SOS, SSPK, MIX, OMR, SQ, €GQ)
J[_Total # of Samples I Allthresholds met ][ @) One or more thresholds not met___|
|samples | 16 | 5 | 11 |

< | >

[ Analysis Completed. ‘ Stop
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Examine and edit a project

You can display electropherogram plots from the Samples and Genotypes tabs of the
Project window to examine the data. These procedures start with the Analysis
Summary tab of the Project window (assuming the analysis is complete).

For more information

58

For more information about any of these tasks, refer to:

For quick set-up instructions, refer to the GeneMapper'™ ID-X Software Version 1.0
Getting Started Guide (Part no. 4375574).

For details about GeneMapper'" ID-X Software features, allele filters, peak
detection algorithms, and project editing, refer to:

GeneMapper'™ ID-X Software Version 1.0 Getting Started Guide
(Part no. 4375574)

GeneMapper'™ ID-X Software Version 1.0 Quick Reference Guide
(Part no. 4375670)

GeneMapper'™ ID-X Software Version 1.0 Reference Guide (Part no. 4375671)

GeneMapper'" ID-X Software Version 1.1 (Mixture Analysis Tool) Getting Started
Guide (Part no. 4396773)

GeneMapper'™ ID-X Software Version 1.1 (Mixture Analysis Tool) Quick
Reference Guide (Part no. 4402094)

GeneMapper'" ID-X Software Version 1.2 Quick Reference Guide (Part
no. 4426482)

GeneMapper'™ ID-X Software Version 1.2 Reference Guide (Part no. 4426481)
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Validation of a DNA typing procedure for human identification applications is an
evaluation of the procedure’s efficiency, reliability, and performance characteristics. By
challenging the procedure with samples commonly encountered in forensic and
parentage laboratories, the validation process uncovers attributes and limitations that
are critical for sound data interpretation in casework (Sparkes, Kimpton, Watson et al.,
1996; Sparkes, Kimpton, Gilbard et al., 1996; Wallin et al., 1998).

We performed experiments to evaluate the performance of the NGM ™ Kit. The
experiments were performed according to the revised guidelines from the Scientific
Working Group on DNA Analysis Methods (SWGDAM, July 10, 2003). Based on these
guidelines, we conducted experiments that comply with guidelines 1.0 and 2.0 and its
associated subsections. This DNA methodology is not novel. (Moretti et al., 2001; Frank
et al., 2001; Wallin et al., 2002; and Holt et al., 2000).
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Developmental validation

This chapter discusses many of the experiments performed by us and provides
examples of results obtained. We chose conditions that produced optimum PCR
product yield and that met reproducible performance standards. It is our opinion that
while these experiments are not exhaustive, they are appropriate for a manufacturer of
STR kits intended for forensic and/or parentage testing use.

IMPORTANT! Perform internal validation studies before using the NGM "™ Kit.

Developmental validation

SWGDAM guideline
1.2.1

SWGDAM guideline

2.10.1

PCR components

60

“Developmental validation is the demonstration of the accuracy, precision, and
reproducibility of a procedure by the manufacturer, technical organization, academic
institution, government laboratory, or other party.” (SWGDAM, July 2003)

“The reaction conditions needed to provide the required degree of specificity and
robustness must be determined. These include thermocycling parameters, the
concentration of primers, magnesium chloride, DNA polymerase, and other critical
reagents.” (SWGDAM, July 2003)

We examined the concentration of each component of the NGM ™" Kit and established
that the concentration of each component was within the range where data indicated
that the amplification met the required performance criteria for specificity, sensitivity,
and reproducibility. For example, 1.0 ng of Control DNA 007 was amplified in the
presence of varying concentrations of magnesium chloride, and the results were
analyzed on an Applied Biosystems'" 3130x! Genetic Analyzer. Results are shown in
Figure 5. The performance of the multiplex is most robust within +20% of the optimal
magnesium chloride concentration.
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parameters

Chapter 5 Experiments and Results

Developmental validation

Figure5 1.0 ng of control DNA 007 amplified for 29 cycles with the NGM™ Kit in the
presence of varying concentrations of magnesium chloride and analyzed on an
Applied Biosystems™ 3130x( Genetic Analyzer
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Thermal cycling parameters were optimized using a Design of Experiments (DOE)
approach that attempts to identify the combination of temperatures and hold times
that produce the best assay performance. Optimal assay performance was determined
through evaluation of assay sensitivity, peak-height balance and resistance to PCR
inhibitors.

For example, annealing temperatures of 55, 57, 59, 61, and 63°C were tested using a
Silver 96-Well GeneAmp™" PCR System 9700 (Figure 6). The PCR products were
analyzed using an Applied Biosystems™ 3130x/ Genetic Analyzer.

Of the tested annealing temperatures, 55 to 61°C produced robust profiles. At 63°C the
yield of the majority of loci was significantly reduced. The optimal combination of
specificity, sensitivity, and resistance to PCR inhibition was observed at 59°C. Thermal
cycler temperature is critical to assay performance; therefore, routine, regularly
scheduled thermal cycler calibration is strongly recommended.
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PCR cycle number

62

Figure 6 Electropherograms obtained from amplification of 1.0 ng of control DNA 007 for 29

cycles at annealing temperatu

res of 55, 57, 59, 61, and 63°C, analyzed on an

Applied Biosystems™ 3130x( Genetic Analyzer, (Y-axis scale 0 to 3,000 RFU)
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57 °C
L L

I T T
L L i
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NGM™ Kit reactions were amplified for 27, 28, 29, 30, and 31 cycles on the Silver 96-
Well GeneAmp"™ PCR System 9700 using 1.0 ng of each of three DNA samples. As
expected, the amount of PCR product increased with the number of cycles. A full
profile was generated for all numbers of thermal cycles (27-31) and off-scale data were

collected for several allele p

eaks at 30 and 31 cycles (Figure 7).

The NGM™ Kit was optimized for use with both 29 or 30 cycles and validated on the
Applied Biosystems"" 3130x! Genetic Analyzer. The optimal DNA input amount per

PCR was found to be 1.0 ng
amplifications. None of the

and 0.5 ng, respectively, for 29- and 30-cycle
cycle numbers tested produced nonspecific peaks.
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Figure7 Representative NGM™ Kit profiles obtained from amplification of 1.0 ng DNA
template using 27, 28, 29, 30, and 31 cycles, analyzed on an Applied Biosystems™ 3130x!
Genetic Analyzer, (Y-axis scale 0 to 8,000 RFU)
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Accuracy, precision, and reproducibility

SWGDAM guideline  “The extent to which a given set of measurements of the same sample agree with their
2.9 mean and the extent to which these measurements match the actual values being
measured should be determined.” (SWGDAM, July 2003)

Accu racy Laser-induced fluorescence detection of length polymorphism at short tandem repeat
loci is not a novel methodology (Holt et al., 2000; and Wallin ef al., 2002). However,
accuracy and reproducibility of NGM™ Kit profiles have been determined from
various sample types. Figure 8 shows the size differences that are typically observed
between sample alleles and allelic ladder alleles on the Applied Biosystems'" 3130x!
Genetic Analyzer with POP-4™ polymer. The x-axis in Figure 8 represents the
nominal nucleotide sizes for the AmpF(STR™ NGM™ Allelic Ladder. The dashed
lines parallel to the x-axis represent the +0.25-nt windows. The y-axis represents the
deviation of each sample allele size from the corresponding allelic ladder allele size.

All sample alleles are within +0.5 nt from a corresponding allele in the allelic ladder.
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Figure 8 Allele Size vs. Allelic Ladder Sizing for 42 samples analyzed on an Applied Biosystems™ 3130x( Genetic
Analyzer.

Size and ladder sizing for the NGM™ Kit were calculated using the GeneScan™ 500 LIZ™ Size Standard using the 3rd
Order Least Squares Method
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Sizing precision enables the determination of accurate and reliable genotypes. Sizing
precision was measured on an Applied Biosystems'" 3130x! Genetic Analyzer. The
recommended method for genotyping is to employ a +0.5-nt “window” around the
size obtained for each allele in the AmpF(STR™ NGM™ Allelic Ladder. A +0.5-nt
window allows for the detection and correct assignment of alleles. Any sample allele
that sizes outside the specified window could be:

* An “off-ladder” allele, that is, an allele of a size that is not represented in the
AmpF(STR™ NGM™ Allelic Ladder

or

* An allele that does correspond to an allelic ladder allele, but whose size is just
outside a window because of measurement error

The measurement error inherent in any sizing method can be defined by the degree of
precision in sizing an allele multiple times. Precision is measured by calculating the
standard deviation in the size values obtained for an allele that is run in several
injections on a capillary instrument or in several lanes of one gel.

Table 7 on page 86 shows typical precision results obtained from five runs

(16 capillaries/run) of the AmpF(STR"™ NGM "™ Allelic Ladder on an

Applied Biosystems"" 3130x! Genetic Analyzer (36-cm capillary and POP-4""
polymer), using the GeneScan"" 500 LIZ"" Size Standard. The results were obtained
within a set of injections on a single capillary array.
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Sample alleles may occasionally size outside of the +0.5-nt window for a respective
allelic ladder allele because of measurement error. The frequency of such an
occurrence is lowest in detection systems having the smallest standard deviations in
sizing. Figure 8 on page 64 illustrates the tight clustering of allele sizes obtained on the
Applied Biosystems™ 3130x! Genetic Analyzer, where the standard deviation in
sizing is typically less than 0.15 nt. The instance of a sample allele sizing outside the
+0.5-nt window because of measurement error is relatively rare when the standard
deviation in sizing is approximately 0.15 nt or less (Smith, 1995).

For sample alleles that do not size within a +0.5-nt window, the PCR product must be
rerun to distinguish between a true off-ladder allele versus measurement error of a
sample allele that corresponds with an allele in the allelic ladder. Repeat analysis,
when necessary, provides an added level of confidence in the final allele assignment.

GeneMapper " ID Software and GeneMapper' " ID-X Software automatically flag
sample alleles that do not size within the prescribed window around an allelic ladder
allele by labelling the allele as OL (off-ladder).

Maximum sizing precision is obtained within the same set of capillary injections.
Cross-platform sizing differences occur due to a number of factors including type and
concentration of polymer, run temperature, and electrophoresis conditions. Variations
in sizing can also occur between runs on the same instrument and between runs on
different instruments of the same platform type because of these factors.

We strongly recommend that the allele sizes be compared to the sizes obtained for
known alleles in the AmpF(STR™ NGM™ Allelic Ladder from the same run and then
be converted to genotypes (as described in “Before you start” on page 34 and on page
45). See Table 4 for the results of five runs of the AmpF(STR™ NGM "™ Allelic Ladder
on an Applied Biosystems'" 3130x! Genetic Analyzer. For more information on
precision and genotyping, see Lazaruk et al., 1998 and Mansfield ef al., 1998.

In Table 4, the mean sizes for all the alleles in each run (16 capillaries) were calculated.
The mean range shown in the table represents the lowest- and highest-mean size
values obtained across all five runs. Similarly, the standard deviation for the allele
sizing was calculated for all the alleles in each run. The standard deviation range
shown in Table 4 represents the lowest and highest standard deviation values obtained
across all five runs.

Table4 Precision results of five runs (16 capillaries/run) of the AmpF(STR™ NGM™ Allelic

Ladder
Allele Mean Standard Dev.
Amelogenin
100.54-100.68 0.052-0.064
106.21-106.34 0.045-0.061
D10S1248
8 76.64-76.67 0.031-0.045
9 80.85-80.9 0.029-0.04
10 85.03-85.09 0.024-0.045
" 89.19-89.25 0.032-0.043
12 93.31-93.37 0.027-0.046
13 97.4-97.48 0.035-0.049
14 101.41-101.48 0.029-0.053
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Allele [continued] Mean Standard Dev.
15 105.32-105.4 0.03-0.05
16 109.24-109.31 0.035-0.046
17 113.18-113.24 0.032-0.048
18 117.14-117.21 0.025-0.044
D12S391
14 229.97-230.12 0.042-0.056
15 233.9-234.05 0.035-0.057
16 237.87-238.01 0.036-0.063
17 241.75-241.91 0.046-0.051
18 245.68-245.83 0.042-0.056
19 249.59-249.73 0.038-0.062
19.3 252.59-252.75 0.034-0.054
20 253.54-253.68 0.034-0.058
21 257.45-257.58 0.04-0.052
22 261.3-261.47 0.037-0.05
23 265.27-265.43 0.039-0.063
24 269.29-269.44 0.039-0.05
25 273.28-273.42 0.034-0.059
26 277.22-277.38 0.045-0.053
27 281.31-281.45 0.049-0.066
D16S539
5 228.68-228.78 0.04-0.05
8 240.7-240.83 0.04-0.052
9 244.772-244.83 0.05-0.055
10 248.73-248.84 0.048-0.059
1 252.73-252.87 0.046-0.063
12 256.78-256.89 0.04-0.055
13 260.8-260.93 0.046-0.061
14 264.82-264.95 0.037-0.056
15 268.86-268.99 0.04-0.054
D18S51
7 262.24-262.34 0.04-0.068
9 270.36-270.49 0.046-0.062
10 274.43-274.56 0.04-0.063
10.2 276.45-276.56 0.05-0.065
11 278.5-278.62 0.048-0.069
12 282.56-282.71 0.059-0.075
13 286.64-286.78 0.038-0.073
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Allele [continued] Mean Standard Dev.
13.2 288.67-288.79 0.057-0.073
14 290.76-290.88 0.046-0.069
14.2 292.75-292.9 0.061-0.075
15 294.83-294.98 0.055-0.082
16 298.95-299.08 0.056-0.077
17 303.1-303.23 0.053-0.088
18 307.24-307.39 0.06-0.079
19 311.39-311.52 0.066-0.086
20 315.53-315.65 0.056-0.087
21 319.66-319.8 0.062-0.077
22 323.86-323.99 0.063-0.082
23 327.92-328.04 0.061-0.076
24 332.03-332.16 0.058-0.079
25 336.16-336.27 0.056-0.085
26 340.27-340.39 0.072-0.079
27 344.39-344.5 0.057-0.077
D195S433
9 127.1-127.2 0.027-0.05
10 130.98-131.06 0.033-0.05
11 134.88-134.96 0.032-0.052
12 138.83-138.9 0.023-0.045
12.2 140.96-141.03 0.027-0.043
13 143.04-143.13 0.03-0.049
13.2 145.21-145.28 0.029-0.041
14 147.28-147.37 0.026-0.051
14.2 149.44-149.52 0.03-0.047
15 151.48-151.57 0.028-0.04
15.2 153.54-153.63 0.036-0.047
16 155.53-155.64 0.032-0.048
16.2 157.58-157.68 0.039-0.051
17 159.55-159.67 0.04-0.056
17.2 161.54-161.66 0.039-0.047
D151656
9 175.77-175.96 0.046-0.09
10 179.67-179.85 0.047-0.08
11 183.53-183.71 0.054-0.08
12 187.39-187.57 0.056-0.078
13 191.24-191.4 0.04-0.069
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Allele [continued] Mean Standard Dev.
14 195.13-195.29 0.04-0.062
14.3 198.01-198.16 0.04-0.061
15 198.87-199.02 0.045-0.07
15.3 201.86-202.01 0.046-0.062
16 202.72-202.88 0.034-0.06
16.3 205.76-205.91 0.05-0.06
17 206.63-206.79 0.044-0.063
17.3 209.66-209.82 0.048-0.064
18.3 213.56-213.73 0.047-0.061
19.3 217.48-217.64 0.044-0.073
20.3 221.4-221.56 0.042-0.064
D21511
24 185.02-185.14 0.042-0.069
24.2 187.02-187.12 0.042-0.066
25 188.98-189.08 0.045-0.066
26 192.92-193.01 0.037-0.056
27 196.87-196.96 0.036-0.052
28 200.75-200.83 0.032-0.052
28.2 202.71-202.81 0.036-0.053
29 204.69-204.78 0.035-0.045
29.2 206.73-206.82 0.039-0.049
30 208.71-208.8 0.04-0.048
30.2 210.68-210.78 0.039-0.049
31 212.7-212.79 0.034-0.05
31.2 214.67-214.76 0.037-0.049
32 216.69-216.78 0.04-0.046
32.2 218.65-218.75 0.04-0.048
33 220.67-220.76 0.031-0.056
33.2 222.62-222.72 0.036-0.059
34 224.74-224.85 0.039-0.048
34.2 226.65-226.74 0.042-0.055
35 228.7-228.8 0.042-0.057
35.2 230.64-230.73 0.041-0.052
36 232.62-232.74 0.042-0.046
37 236.68-236.78 0.037-0.052
38 240.61-240.71 0.04-0.052
D2251045
8 79.99-80.08 0.034-0.058
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Allele [continued] Mean Standard Dev.

9 83.08-83.18 0.037-0.058
10 86.14-86.25 0.041-0.063
M 89.2-89.33 0.043-0.065
12 92.26-92.37 0.047-0.067
13 95.29-95.43 0.045-0.069
14 98.33-98.46 0.044-0.07
15 101.3-101.42 0.054-0.066
16 104.2-104.32 0.043-0.064
17 107.13-107.24 0.054-0.068
18 110.06-110.17 0.052-0.069
19 113.02-113.13 0.046-0.059

D251338
15 289.59-289.7 0.038-0.054
16 293.68-293.78 0.036-0.053
17 297.73-297.82 0.042-0.055
18 301.81-301.9 0.046-0.064
19 305.9-306 0.043-0.06
20 310.03-310.11 0.047-0.057
21 314.12-314.22 0.042-0.062
22 318.22-318.31 0.034-0.06
23 322.3-322.39 0.044-0.062
24 326.38-326.46 0.044-0.058
25 330.46-330.55 0.038-0.06
26 334.54-334.61 0.047-0.056
27 338.63-338.71 0.046-0.057
28 342.95-343.05 0.037-0.061

D2S441
9 80.29-80.38 0.028-0.054
10 84.41-84.5 0.033-0.057
11 88.51-88.62 0.03-0.062
12 91.66-91.76 0.046-0.067
13 92.58-92.69 0.045-0.062
14 96.49-96.62 0.036-0.069
15 100.51-100.63 0.045-0.067
16 104.4-104.53 0.038-0.056

D351358
12 134.88-134.99 0.043-0.064
13 138.98-139.12 0.042-0.064
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Allele [continued] Mean Standard Dev.
14 143.23-143.38 0.035-0.051
15 147.4-147.55 0.047-0.057
16 151.78-151.91 0.042-0.063
17 155.99-156.16 0.051-0.074
18 160.04-160.21 0.063-0.075
19 163.88-164.06 0.064-0.079

D8S1179
8 123.54-123.64 0.04-0.068
9 127.61-127.71 0.039-0.071
10 131.7-131.81 0.045-0.064
M 135.86-135.95 0.045-0.07
12 140.1-140.2 0.046-0.056
13 144.67-144.77 0.043-0.058
14 149.13-149.23 0.046-0.07
15 153.45-153.57 0.053-0.069
16 157.7-157.85 0.054-0.073
17 161.86-162 0.056-0.086
18 165.94-166.07 0.054-0.085
19 169.99-170.15 0.054-0.096
FGA
17 233.22-233.34 0.032-0.044
18 237.01-237.13 0.036-0.047
19 240.8-240.93 0.04-0.053
20 244.61-244.74 0.04-0.049
21 248.43-248.55 0.038-0.045
22 252.24-252.35 0.034-0.057
23 256.09-256.19 0.028-0.047
24 259.9-260.01 0.041-0.051
25 263.74-263.86 0.035-0.049
26 267.59-267.7 0.035-0.055
26.2 269.46-269.57 0.029-0.045
27 271.5-271.62 0.037-0.054
28 275.35-275.47 0.036-0.046
29 279.2-279.31 0.03-0.051
30 282.97-283.07 0.036-0.053
30.2 285.24-285.36 0.035-0.053
31.2 289.12-289.23 0.028-0.065
32.2 292.98-293.09 0.042-0.054
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Allele [continued] Mean Standard Dev.
33.2 296.88-296.97 0.044-0.051
42.2 332.47-332.54 0.03-0.062
43.2 336.37-336.45 0.031-0.055
44.2 340.44-340.51 0.034-0.055
45.2 344.38-344.45 0.033-0.055
46.2 348.02-348.09 0.036-0.044
47.2 351.82-351.85 0.036-0.05
48.2 355.71-355.78 0.031-0.052
50.2 363.15-363.2 0.032-0.045
51.2 366.92-366.96 0.034-0.052

THO1
4 181.53-181.67 0.044-0.065
5 185.44-185.58 0.039-0.063
6 189.32-189.46 0.037-0.066
7 193.2-193.33 0.028-0.058
8 197.05-197.17 0.032-0.053
9 200.93-201.03 0.036-0.047
9.3 203.93-204.03 0.037-0.052
10 204.85-204.95 0.031-0.051
11 208.78-208.9 0.036-0.048
13.3 219.64-219.75 0.038-0.047
VWA
M 153.74-153.84 0.041-0.065
12 157.91-158.03 0.038-0.067
13 162.04-162.18 0.039-0.069
14 166.28-166.42 0.054-0.078
15 170.22-170.34 0.047-0.081
16 0.043-0.087 0.043-0.087
17 178.23-178.36 0.039-0.074
18 182.17-182.29 0.044-0.074
19 186.13-186.25 0.044-0.075
20 190.06-190.2 0.039-0.067
21 193.95-194.08 0.039-0.058
22 197.85-197.97 0.04-0.057
23 201.69-201.79 0.032-0.051
24 206.01-206.12 0.032-0.063
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Extra peaks in the electropherogram

Causes of extra
peaks

Stutter products

72

Peaks other than the target alleles may be detected on the electropherogram. Causes
for the appearance of extra peaks include stutter products, incomplete

3" A nucleotide addition (at the n-1 position), dye artifacts, and mixed DNA samples
(see DAB Standard 8.1.2.2).

Stutter is a well-characterized PCR artifact that refers to the appearance of a minor
peak one repeat unit smaller (or less frequently, one repeat larger) than the major STR
product (Butler, 2005; Mulero et al., 2006). Sequence analysis of stutter products at
tetranucleotide STR loci has revealed that the stutter product is missing a single
tetranucleotide core repeat unit relative to the main allele (Walsh et al., 1996).

The proportion of the stutter product relative to the main allele (percent stutter) is
measured by dividing the height of the stutter peak by the height of the main allele
peak. Peak heights were measured for amplified samples (n = 1023) at the loci used in

the NGM " Kit. All data were generated on the Applied Biosystems'" 3130x! Genetic
Analyzer.

Due to the enhanced buffer system developed for the NGM ™ Kit, plus stutter peaks
may be encountered at other loci more frequently than with older AmpF(STR™
chemistries (for example, the SGM Plus™ Kit). Laboratories should evaluate the
occurrence of plus stutter peaks and develop appropriate interpretation guidelines as
part of an internal validation study:.

Some conclusions from these measurements and observations are:

e For each NGM" Kit locus, the percent stutter generally increases with allele length,
as shown in Figure 9 to Figure 13 on page 73 to 75.

* Smaller alleles display a lower level of stutter relative to the longer alleles within
each locus.

* Each allele within a locus displays a percent stutter that is consistent.

e Stutter filter sets in GeneMapper " ID Software and GeneMapper'" ID-X Software,
calculated as the mean stutter for the locus plus three standard deviations
(n=1023), are shown in Table 5 on page 75. Peaks in the stutter position that are
above the stutter filter percentage specified in the software are not filtered. Peaks in
the stutter position that have not been filtered and remain labeled can be further
evaluated. For evaluation of mixed samples, see Figure 24 on page 90.

* The measurement of percent stutter for allele peaks that are off-scale may be
unusually high due to artificial truncation of the main allele peak.
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Figure 9 Stutter percentages for D1051248, D125391 and D165539 loci (Blue and red colors
indicate loci labeled with FAM™ and PET™ dyes respectively)
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Figure 10 Stutter percentages for the D18551, D195S433 and D151656 loci (Green, black, and
red colors indicate loci labeled with VIC™, NED™, and PET™ dyes, respectively)
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Figure 11 Stutter percentages for the D21511, D2251045 and D251338 loci (Green, black/
gray, and blue colors indicate loci labeled with VIC™, NED™ and FAM™ dyes, respectively.
Black and gray data points associated with the D2251045 locus indicate minus- and plus-
stutter, respectively)
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Figure 12 Stutter percentages for the FGA and THO1 loci (Black data points indicate loci labeled
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with NED™ dye)
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Figure 13 Stutter percentages for the D25441, D351358, D8S1179, and vWA loci (Red, green,
and blue colors indicate loci labeled with and PET™, VIC™, and FAM™ dyes, respectively)
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Table 5 Marker-specific stutter filter percentages for NGM™ Kit loci

Locus % Stutter
D10S1248 12.39
vWA 11.83
D165S539 10.12
D251338 12.83
D8S1179 10.31
D21S11 10.87
D18S51 14.08
D2251045 (-3nt) 18.05
D22S1045 (+3 nt) 7.63
D19S433 11.20
THOT1 4.27
FGA 12.10
D2S441 9.45
D351358 13.07
D151656 (-4nt) 14.46
D1S1656 (-2nt)T 4.70
D125391 15.27

t The - 2nt stutter filter is not included in GeneMapper™ /D Software v3.2.1NGM_panel_v2 due to functional
limitations of the software.
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Addition of 3" A

nucleotide

76

IMPORTANT! The values shown are the values we determined during developmental
validation studies. We recommend that laboratories perform internal validation
studies to determine the appropriate values to use.

Many DNA polymerases can catalyze the addition of a single nucleotide
(predominantly adenosine) to the 3" ends of double-stranded PCR products (Clark,
1988; Magnuson et al., 1996). This non-template addition results in a PCR product that
is one nucleotide longer than the actual target sequence. The PCR product with the
extra nucleotide is referred to as the “+A” form.

The efficiency of +A addition is related to the particular sequence of the DNA at the 3’
end of the PCR product. The NGM"" Kit includes two main design features that
promote maximum +A addition:

¢ The primer sequences have been optimized to encourage +A addition.

® The new, highly robust PCR chemistry allows complete +A addition with a short
final incubation at 60 °C for 10 minutes.

This final extension step gives the DNA polymerase additional time to complete +A
addition to all double-stranded PCR products. See Figure 14 on page 76 for examples
of incomplete and normal +A addition. Final extension incubation for longer than the
recommended 10 minutes may result in double +A addition, in which two non-
template adenosine residues are added to the PCR product. Double +A addition can
cause “shoulders” on the right side of main allele peaks, and is therefore to be avoided.

Figure 14 Omitting the final extension step results in shoulders on main allele peaks due to
incomplete A nucleotide addition. Data are from an Applied Biosystems™ 3130x{ Genetic
Analyzer using the NGM™ Kit
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Due to improved PCR buffer chemistry, the lack of +A addition is generally less an
issue with the NGM " Kit than with earlier generation kits. However, “shouldering” of
allele peaks may still be observed if the amount of input DNA is greater than that

recommended by the NGM " Kit protocol. Amplification of excess input DNA may
also result in offscale data.

Artifacts and anomalies are seen in all molecular biological systems. Artifacts are
typically reproducible while anomalies are non-reproducible, intermittent occurrences
that are not observed consistently in a system (for example, spikes and baseline noise).
Due to improvements in PCR primer manufacturing processes, the incidence of
artifacts has been greatly reduced in the NGM"" Kit. NGM " Kit electropherograms are
essentially free of reproducible dye artifacts within the Kit's read region of 68-407 nt.
Figure 15 on page 78 shows the very low baseline level fluorescence of a typical
negative control PCR using the NGM ™ Kit.

Most STR loci produce minus-stutter peaks as a by-product of PCR amplification. A
process of “slippage” has been proposed as a molecular mechanism for stutter, where
the Tag DNA polymerase enzyme “slips” on the template DNA during replication and
produces a minority PCR product that is shorter than the template strand, usually by
one repeat unit. The stutter process may also occur in the opposite direction to produce
amplicon DNA that is usually one repeat unit longer than the template strand, termed
plus-stutter. While plus-stutter is normally much less significant than minus-stutter in
STR loci with tetranucleotide repeats, the incidence of plus-stutter may be more
significant in trinucleotide repeat-containing loci. The D2251045 locus in the NGM ™
Kit is a trinucleotide repeat locus, and shows an elevated level of plus-stutter. For
example, Figure 17 on page 79 is an electropherogram of the D2251045 locus showing
plus stutter. GeneMapper " ID Software and GeneMapper " ID-X Software analysis
parameter files supplied for use with the NGM ™ Kit contain a plus-stutter filter for the
D2251045 locus to prevent these peaks from being called in normal profiles.

Plus stutter may also be visible at tetranucleotide repeat loci in next generation NGM™

Kits due to improvements in buffer formulation over previous kits. Laboratories
should evaluate the occurrence of plus stutter across the profile as part of internal
validation studies.

Figure 16 on page 78 shows an example of a non-standard (minus 2-nt) stutter that
may be observed in certain STR loci such as D151656 with more complex nucleotide
sequences that include regions of dinucleotide TG repeats. Genotyping may result in
the detection of these artifacts as off-ladder (OL) alleles.

It is important to consider possible noise and artifacts when interpreting data from the
NGM™ Kit on the Applied Biosystems" 3500/3500xL and 3130/3130x!, ABI PrisM "
3100/3100-Avant, and ABI PRIsM"" 310 Genetic Analyzers. Note that a high degree of
magnification is used in the sample electropherograms shown in Figure 15 to Figure 17
on page 78 to 79.

AmpFISTR™NGM™ PCR Amplification Kit User Guide 77



Extra peaks in the electropherogram

Chapter 5 Experiments and Results

Figure 15 Examples of fluorescence background in data produced on an Applied Biosystems™ 3130x{ Genetic Analyzer,

(Y-axis scale 0-100 RFU)
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Figure 16 Example of a -2 nt reproducible artifact at the D151656 locus. Data produced on an Applied Biosystems™
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Figure 17 NGM™ Kit electropherogram showing plus stutter associated with the D2251045 STR locus. Data produced on
an Applied Biosystems™ 3130x! Genetic Analyzer
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Characterization of loci

SWGDAM guideline  “The basic characteristics of a genetic marker must be determined and documented.”
2.1 (SWGDAM, July 2003)

This section describes basic characteristics of the 15 loci and the sex-determining

marker, Amelogenin, which are amplified with the NGM " Kit. Most of these loci have
been extensively characterized by other laboratories.

Nature of the The primers for the Amelogenin locus flank a 6-nucleotide deletion within intron 1 of

polymorphisms the X homolog. Amplification results in 104-nt and 110-nt products from the X and Y
chromosomes, respectively. (Sizes are the actual nucleotide size according to
sequencing results, including 3" A nucleotide addition, and size may not correspond
exactly to allele mobility observed on capillary electrophoresis platforms.) With the
sole exception of D2251045, a trinucleotide STR, the remaining NGM " Kit loci are
tetranucleotide short tandem repeat (STR) loci. The length differences among alleles of
a particular locus result from differences in the number of repeat units.

All the alleles in the AmpF(STR™ NGM™ Allelic Ladder, including microvariants,
have been subjected to sequencing at Life Technologies. In addition, other groups in
the scientific community have sequenced alleles at some of these loci (Nakahori et al.,
1991; Puers et al., 1993; Moller et al., 1994; Barber et al., 1995; Moller and Brinkmann,
1995; Barber et al., 1996; Barber and Parkin, 1996; Brinkmann et al., 1998; Momhinweg
et al., 1998; Watson et al., 1998). Among the various sources of sequence data on the
NGM"™ Kit loci, there is consensus on the repeat patterns and structure of the STRs.
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Inheritance

Mapping

Genetic linkage

80

The Centre d'Etude du Polymorphisme Humain (CEPH) has collected DNA from
families of Utah Mormon, French Venezuelan, and Amish descent. These DNA sets
have been extensively studied all over the world and are routinely used to characterize
the mode of inheritance of various DNA loci. Each family set contains three
generations, generally including four grandparents, two parents, and several
offspring. Consequently, the CEPH family DNA sets are ideal for studying inheritance
patterns (Begovich et al., 1992).

The NGM " Kit loci have been mapped, and the chromosomal locations have been
published (Nakahori ef al., 1991; Edwards et al., 1992; Kimpton et al., 1992; Mills et al.,
1992; Sharma and Litt, 1992; Li et al., 1993; Straub et al., 1993; Barber and Parkin, 1996).

Two sets of STR loci in the NGM ™ Kit are located on the same chromosomes. VWA and
D125391 are located approximately 6.3 million bp apart on the p arm of chromosome
12, while D251338 and D25441 are located approximately 150 million bp apart on
opposite arms of chromosome 2. Linkage disequilibrium analysis was conducted on
the genotype results from 996 individuals of three ethnic groups (see “Population
data” on page 91). STR locus genotype results from the population study were
analyzed using the Linkage Disequilibrium module of GenePop software version
4.0.10 (Raymond and Rousset, 1995; Rousset, 2008). See Table 6 for results.

The relatively high probability values indicate that there is no statistically significant
linkage disequilibrium found between the pairs of loci located on the same
chromosome.

An independent analysis of the same set of population data by Budowle et al. (2010)
concluded that there was no evidence of LD between or within any of the NGM™ Kit,
and that the multiplication rule could therefore be used for all markers contained in
the 15 STR markers contained in the kit for the purpose of calculating the rarity of a
DNA profile. However, they cautioned that, while there was no evidence of LD at the
population level, the independence of vWA and D125391 could not be assumed for the
purpose of kinship analysis, due to the proximity of the loci on Chromosome 12.

Table 6 GenePop LD Result (p value for pairwise analysis of loci)

Chromosome ican-
Chromosome Nuclear African Caucasian = Hispanic
Locus pozfi?,nf Coordinates® o (N =350 (N=293)
(million bp) | (N = 350)
VWA p13.31 5.9
D12S391 p13.2 12.2 0.86 0.29 0.27
D2S441 pl4 68
D251338 | g35 218 0.1 0.32 0.19

1t STR locus mapping data was obtained from the NCBI Map Viewer http://www.ncbi.nlm.nih.gov/projects/
mapview/map_search.cgi?taxid=9606 or the UCSC Genome Browser (http://genome.ucsc.edu/). GenePop
LD analysis probability results (p values) greater than 0.05 were considered to indicate that linkage
disequilibrium between the loci within the population tested was not statistically significant.
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Species specificity

SWGDAM Guideline  “For techniques designed to type human DNA, the potential to detect DNA from
2.2 forensically relevant nonhuman species should be evaluated.” (SWGDAM, July 2003)

The NGM" Kit provides the required specificity for detecting human alleles.

Nonhuman studies

Nonhuman DNA may be present in forensic casework samples. The following species
were tested (in the specified amounts) using standard PCR and capillary
electrophoresis conditions for the NGM ™ Kit.

¢ Primates: gorilla, chimpanzee, and macaque (1.0 ng each)

* Non-primates: mouse, dog, sheep, pig, rabbit, cat, horse, hamster, rat, chicken,
and cow (5.0 ng each)

* Microorganisms: Candida albicans, Staphylococcus aureus, Escherichia coli,
Neisseria gonorrhoeae, Bacillus subtilis, and Lactobacillus rhamnosus (equivalent
to 105 copies)

Results were assessed for the presence of any amplified peaks that would indicate
cross reactivity of the NGM"" Kit with any of these non-human species.

Figure 18 on page 82 shows example electropherogram results from the species
specificity tests. The chimpanzee and gorilla DNA samples produced partial profiles
within the 70 — 283 nucleotide region (gorilla data not shown). Macaque DNA
produced a strong Amelogenin-X peak and two small out-of-marker-range peaks in
PET (data not shown).
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Figure 18 Representative electropherograms from a species specificity study including positive and non-template controls
(NTC)
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The microorganisms, cow, sheep, pig, dog, cat, chicken, hamster, mouse, rabbit, and rat
did not yield detectable products. Of the non-primates, only horse DNA produced a
96-bp fragment near the amelogenin locus in the VIC™ dye.

Sensitivity

SWGDAM guideline “When appropriate, the range of DNA quantities able to produce reliable typing
2.3 results should be determined.” (SWGDAM, July 2003)

mportance o e recommended amount of input or the it1s 1.0 ng, based on
Import f Th ded f input DNA f he NGM™ Kit is 1.0 g, based
quantification quantification using either the Quantifiler'" Human or Quantifiler" Duo

Quantification Kit and individual laboratories should determine the optimum input
DNA amount according to the quantification method in use in the laboratory. If the
sample contains degraded or inhibited DNA, amplification of a higher concentration
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of DNA may be beneficial. In Figure 19 on page 84, the control DNA 007 was serially
diluted from 2.0 ng to 0.062 ng. Full profiles (32 PCR products) were consistently
obtained at 0.125 ng, but occasional partial profiles missing 1 — 3 alleles were observed
at 0.062 ng.

Effect of DNA If too much DNA is added to the PCR reaction, the increased amount of PCR product
quantity on results that is generated can result in:

* Fluorescence intensity that exceeds the linear dynamic range for detection by the
instrument (“off-scale” data).

* Off-scale data. Off-scale data is a problem because:

— Quantification (peak height and area) for off-scale peaks is not accurate. For
example, an allele peak that is off-scale can cause the corresponding stutter
peak to appear higher in relative intensity, thus increasing the calculated
percent stutter.

— Multicomponent analysis of off-scale data is not accurate. This inaccuracy
results in poor spectral separation (“pull-up”).

¢ Incomplete +A nucleotide addition.
To address these issues, reamplify the sample using less DNA.

When the total number of allele copies added to the PCR is extremely low, unbalanced
amplification of the alleles may occur because of stochastic fluctuation.

Individual laboratories may find it useful to determine an appropriate minimum peak
height threshold based on their own results and instruments using low amounts of
input DNA.
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Figure 19 Electropherograms for 29-cycle amplifications using 2 ng, 1 ng, 0.50 ng, 0.25 ng, 0.125 ng, and 0.062 ng of
control DNA 007. Electrophoresis was performed on an Applied Biosystems™ 3130x{ Genetic Analyzer. Note that the y-axis
scale is magnified for the smaller input amounts of DNA
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SWGDAM guideline

2.4

Degraded DNA

84

“The ability to obtain results from DNA recovered from biological samples deposited
on various substrates and subjected to various environmental and chemical insults has
been extensively documented. In most instances, assessment of the effects of these
factors on new forensic DNA procedures is not required. However, if substrates and/or
environmental and/or chemical insults could potentially affect the analytical process,
then the process should be evaluated using known samples to determine the effects of
such factors.” (SWGDAM, July 2003)

As the average size of degraded DNA approaches the size of the target sequence, the
amount of PCR product generated is reduced because of the reduced number of intact
templates in the size range necessary for amplification.
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Degraded DNA was prepared to examine the potential for differential amplification of
loci. High-molecular-weight Raji DNA was sonicated and incubated with increasing
doses of DNase I (0 to 6 Units) for 20 minutes (Bender et al., 2004). The DNA was
examined by agarose gel analysis to determine the average size of the DNA fragments
at each time point.

Amplification of 1.0 ng of degraded DNA using the NGM ™ Kit was performed. As the
DNA became progressively degraded, the loci failed to amplify robustly in order of
decreasing size. Preferential amplification was not observed.

Figure 20 Amplification of Raji DNA samples sonicated and incubated with increasing doses of DNase |. PCR
amplification was done for 29 cycles, with electrophoresis being performed on an Applied Biosystems™ 3130xL. Panels 1,
2, 3, and 4 correspond to 0, 4, 5, and 6 units of DNase |. Note that the y-axis scale is magnified for more degraded
samples, which generate lower peak heights
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Effect of inhibitors
— hematin

The larger loci contained in the NGM " Kit, which fail to amplify in significantly
degraded samples may be recovered by using the AmpF(STR™ MiniFler " Kit. The
amplicon size for the larger loci has been reduced to facilitate performance on

degraded samples. For more information please refer to the AmpF(STR™ MiniFler™
PCR Amplification Kit User's Guide (Part no. 4374618).

Heme compounds have been identified as PCR inhibitors in DNA samples extracted
from bloodstains (DeFranchis et al., 1988; Akane et al., 1994). It is believed that the
inhibitor is co-extracted and co-purified with the DNA and subsequently interferes
with PCR by inhibiting polymerase activity.
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To examine the effects of hematin on the performance of the NGM"" Kit, 1.0 ng of
control DNA 007 was amplified in the presence of increasing concentrations of
hematin for 29 cycles of amplification (Figure 21 on page 86).The concentrations of
hematin used were 0 uM, 50 uM, 100 uM, 150 uM, and 200 uM (see Table 7 on page 86).

Figure 21 Electropherograms for the AmpF(STR™ NGM™ and SGM Plus™ Kits show the improved performance of the
NGM™ Kit in the presence of hematin compared with previous AmpF(STR™ kits. In order from top to bottom, the panels show
profiles for: NGM™ Kit uninhibited control, NGM™ Kit with 200 uM hematin, SGM Plus™ Kit uninhibited control and SGM
Plus™ Kit with 200 uM hematin. The SGM Plus™ and NGM™ Kits were amplified for 28 and 29 cycles, respectively
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Table 7 NGM™ Kit performance in simulated hematin inhibition (n = 3)

Hematin Concentration Number of Alleles Detected®
0uM 32,32, 32
50 uM 32,32, 32
100 uM 32,32, 32
150 uM 32,32, 32
200 uM 32,32, 32

T Only those peaks >50 RFU were counted. A complete profile with control DNA 007 yields 32 peaks using
the NGM™ Kit on an Applied Biosystems™ 3130x! instrument.
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Effect of inhibitors  Traces of humic acid may inhibit the PCR amplification of DNA evidence collected

— humic acid from soil. Amplification of 1 ng of control DNA 007 in the presence of increasing
amounts of humic acid was performed using the NGM"" Kit for 29 cycles of
amplification (see Figure 22). The concentrations of humic acid tested were 0, 20, 40,
60, and 80 ng/uL (see Table 8 on page 87).

Figure 22 Electropherograms for the AmpF(STR™ NGM™ and SGM Plus™ Kits show improved performance of the NGM™
Kit in the presence of humic acid compared to previous AmpF(STR™ kits. In order from top to bottom, the panels show
profiles for: NGM™ Kit uninhibited control, NGM™ Kit with 80 ng/uL humic acid, SGM Plus™ Kit uninhibited control, and
SGM Plus™ Kit with 80 ng/uL humic acid. The SGM Plus™ and NGM™ Kits were amplified for 28 and 29 cycles,

respectively
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Table 8 NGM™ Kit performance in simulated model of humic acid inhibition (n = 3)

Humic acid concentration Number of alleles detected®
0 ng/uL 32, 32, 32
20 ng/uL 32,32, 32
40 ng/uL 32,32, 32
60 ng/uL 32,32, 32
80 ng/uL 32, 32, 32

T Only those peaks >50 RFU were counted. A complete profile with control DNA 007 yields 32 peaks using
the NGM™ Kit on an Applied Biosystems™ 3130x! instrument.
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Mixture studies

SWGDAM guideline
2.8

Mixture studies

88

“The ability to obtain reliable results from mixed source samples should be
determined.” (SWGDAM, July 2003)

Evidence samples may contain DNA from more than one individual. The possibility of
multiple contributors should be considered when interpreting the results. We
recommend that individual laboratories determine a minimum peak height threshold
based on validation experiments performed in each laboratory to avoid typing when
stochastic effects are likely to interfere with accurate interpretation of mixtures.

Evidence samples that contain body fluids and/or tissues originating from more than
one individual are an integral component of forensic casework. Therefore, it is
essential to ensure that the DNA typing system is able to detect DNA mixtures. Mixed
samples can be distinguished from single-source samples by:

¢ The presence of more than two alleles at a locus

* The presence of a peak at a stutter position that is significantly greater in
percentage than typically observed in a single-source sample

¢ Significantly imbalanced alleles for a heterozygous genotype

The peak height ratio is defined as the height of the lower peak (in RFU) divided by the
height of the higher peak (in RFU), expressed as a percentage. Mean, median,
minimum, and maximum peak height ratios observed for alleles in the NGM " Kit loci
in unmixed population database samples are shown in Figure 23 below.

Figure 23 Heterozygote ratios for 1 ng of input DNA amplified for 29 cycles with the NGM™ Kit.
The distribution of intra-locus peak height ratios are expressed as plus and minus percent, by
locus. Green boxes show the middle 50% or interquartile range (IQR). Box halves below and
above median show the second and third quartile, respectively. “Whiskers” indicate 1.5 IQR from
the upper and lower margins of the IQR. Red diamonds are outlier data points more than 1.5
IQR from the median
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If an unusually low peak height ratio is observed for one locus, and there are no other
indications that the sample is a mixture, the sample may be reamplified and
reanalyzed to determine if the imbalance is reproducible. Possible causes of imbalance
at a locus are:

* Degraded DNA

* Presence of inhibitors

¢ Extremely low amounts of input DNA

* A mutation in one of the primer binding sites

* Presence of an allele containing a rare sequence that does not amplify as
efficiently as the other allele

Resolution of A sample containing DNA from two sources can comprise (at a single locus) any of the
genotypes in mixed  seven genotype combinations (see below).
samples * Heterozygote + heterozygote, no overlapping alleles

(four peaks)

* Heterozygote + heterozygote, one overlapping allele
(three peaks)

* Heterozygote + heterozygote, two overlapping alleles
(two peaks)

* Heterozygote + homozygote, no overlapping alleles
(three peaks)

¢ Heterozygote + homozygote, overlapping allele
(two peaks)

* Homozygote + homozygote, no overlapping alleles
(two peaks)

¢ Homozygote + homozygote, overlapping allele
(one peak)

Specific genotype combinations and input DNA ratios of the samples contained in a
mixture determine whether or not it is possible to resolve the genotypes of the major
and minor component(s) at a single locus.

The ability to obtain and compare quantitative values for the different allele peak

heights on Applied Biosystems™ instruments provides additional valuable data to
aid in resolving mixed genotypes.

Ultimately, the likelihood that any sample is a mixture must be determined by the
analyst in the context of each particular case, including the information provided from
known reference sample(s).

Limit of detection Mixtures of two DNA samples were examined at various ratios (0:1, 1:1, 3:1, 7:1, 15:1,

of the minor 1:0). The total amount of genomic input DNA mixed at each ratio was 1.0 ng. The

component samples were amplified in a GeneAmp"" PCR System 9700, then electrophoresed and
detected using an Applied Biosystems'" 3130x! Genetic Analyzer.
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The results of the mixed DNA samples are shown in Figure 24 on page 90 where
samples A and B were mixed according to the ratios indicated. The minor component
allele calls at non-overlapping loci are highlighted. Detection of full profiles for the
minor contributor was possible at ratios of 3:1 (0.750:0.250 ng) and 7:1 (0.875:0.125 ng).
Generally, 15:1 ratios resulted in partial profiles for the minor component. The profiles
of these samples are described in Table 9 on page 90.

Figure 24 Amplification of DNA mixtures at various ratios. Panels show electropherograms for (top to bottom): Major
contributor only, 1:1 mixture (maj:min), 3:1 mixture, 7:1 mixture, 10:1 mixture and 15:1 mixture. The experiment was
performed with both 29- and 30 cycle amplification; electropherograms shown are from the 29-cycle amplification
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Table 9 Genotypes of mixed DNA samples
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Locus Sample A Genotype Sample B Genotype
D10S1248 13, 14 12, 15

VWA 14,17 17,19
D16S539 10, 11 9,12
D251338 17, 23 17, 20

AMEL XY X

DS1179 11,14 10,11
D21511 29, 35 31.2,32.2
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Locus Sample A Genotype Sample B Genotype
D18S51 15, 16 13, 14
D22510 45,15 15, 16
D195433 11,17.2 13

THO1 7,8 6,93

FGA 19, 25 22,23
D2S441 11,12 11, 14
D351358 14,17 15, 16
D151656 12, 18.3 11, 15
D125391 18, 18.3 18, 22

Population data

SWGDAM guideline
2.7

Overview

Population
samples used in
these studies

“The distribution of genetic markers in populations should be determined in relevant
population groups.” (SWGDAM, July 2003)

The NGM " Kit contains loci for which extensive population data are available. For

additional information on 11 loci shared between the kits, see the population data and

additional studies section of the AmpF(STR™ SGM Plus™ PCR Amplification Kit
User’s Manual (Part no. 44309589).

The NGM™ Kit was used to generate the population data provided in this section.
Whole blood samples, provided by the Insterstate Blood Bank (Memphis, Tennessee),
were collected in the United States (with no geographical preference) from randomly
selected individuals of known ethnicities. Ethnicities of sample donors were:

¢ African-American — 344 samples
¢ Caucasian — 346 samples
¢ Hispanic — 390 samples
DNA was extracted using an ABI PRisM"" 6100 Nucleic Acid PrepStation.

In addition to the alleles that were observed and recorded in our databases, other
alleles have been published or reported to us by other laboratories (see the STRBase at
www.cstl.nist.gov/div831/strbase).

New Primers added to the NGM™ Kit

Comparison of
primer sequences
with other
AmpF(STR™ Kits

Both the NGM " and NGM SElect™ Kits contain an additional unlabeled primer for the
D851179 locus to allow detection of a rare population-specific SNP-containing allele
affecting one of the primer binding regions for that locus. The additional D8 primer
was first introduced in the Identifiler " kit (released 2001) and has been included in
all other AmpF(STR™ kits containing the D851179 locus since that tine. This primer is
not included in AmpF(STR™ kits released before 2001, including the SGM Plus™ kit.
Laboratories may therefore see occasional non-concordance at the D851179 locus
when comparing results from different AmpF(STR™ kits.
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Inclusion of three
SNP-specific
primers to address
mutations at the
Amelogenin,
D2S441, and
D2251045 loci

92

Both the NGM™ and NGM SElect™ Kits also contain slight modifications to the
Amelogenin primers to reduce inter-species cross-reactivity compared to previous

AmpF(STR™ kits.

After the initial release of the NGM " Kit in early 2010, more recent population study
results showed the existence of certain mutations that affected primer binding sites at
three of the NGM"" Kit loci: amelogenin, D25441, and D2251045 (Carolyn Hill and
John Butler, National Institute of Standards and Technology, personal communication).
The mutations, when present, caused the drop-out of affected alleles. While the
mutations are relatively rare and restricted primarily to specific population groups, the
decision was made to include one additional PCR primer for each of the affected loci to
allow the mutant alleles to be detected by the NGM " Kit. The inclusion of the
additional primers also required a minor re-optimization of the NGM"" Kit Master Mix
to support the expanded primer mix.

Subsequent validation experiments showed that other aspects of kit performance
remained unaffected by the additional primers and the minor re-optimization of the
Master Mix. Current versions of both the AmpF(STR™ NGM™ and NGM SElect ™
Kits contain identical sets of primers for the 16 loci they have in common; the only
difference between the kits is the presence of primers for the SE33 locus in the NGM
SElect™ Kit.

The first commercially available batches of the NGM ™ Kit to include the additional
primers and benefit from the minor Master Mix re-optimisation were 200 Reaction Kit
Lot 1105011 (Part no. 4415020) and 1000 Reaction Kit Lot 1106009 (Part no. 4415021).
These lots were released in late summer 2011.

Note: The inclusion of the three additional primers in the NGM SElect"" Kit and the
associated buffer optimisation studies were conducted as part of the original
development of the NGM SElect™" Kit.

Figure 25 shows in the new version of the NGM"" Kit electropherograms with

examples where the additional primers for amelogenin, D25441 and, D2251045 allow
mutant alleles at these loci to be detected, whereas they had not been detected by the

™

original version of the NGM ™ Kit.
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Mutation rate

Figure 25 New PCR primers added to D2251045, amelogenin and D2S441 loci. The
electropherograms below show the effects of adding additional PCR primers to amplify known
mutant alleles that would otherwise not be detected. Panels A and B show the D2251045 locus
for individual CV133 without (A] and with (B) the extra primer; the additional primer allowed the
variant of allele 15 to be detected. Panels C and D show the amelogenin locus for individual

CV423 without (C) and with (D) the extra primer; the additional primer allowed the variant of the
X allele to be detected. Panels E and F show the D25441 locus for individual CV1054 without (E)
and with (F) the extra primer; when amplified, the variant allele was always seen to type as a
9.1 microvariant
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Mutation rate

Estimating germ-
line mutations

Estimation of spontaneous or induced germ-line mutation at genetic loci can be
achieved by comparing the genotypes of offspring to those of their parents. From such
comparisons the number of observed mutations are counted directly.

In previous studies, genotypes of ten STR loci that were amplified by the AmpF(STR™
SGM Plus™ PCR Amplification Kit were determined for a total of 146 parent-

offspring allelic transfers (meioses) at the Forensic Science Service, Birmingham,

England. One length-based STR mutation was observed at the D18511 locus;
mutations were not detected at any of the other nine STR loci. The D18511 mutation

was represented by an increase of one 4-nt repeat unit, allele 17 was inherited as allele
18 (single-step mutation). The maternal/paternal source of this mutation could not be
distinguished.
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Additional Additional studies (Edwards et al., 1991; Edwards et al., 1992; Weber and Wong, 1993;

mutation studies Hammond et al., 1994; Brinkmann ef al., 1995; Chakraborty et al., 1996, Chakraborty et
al., 1997; Brinkmann et al., 1998; Momhinweg et al., 1998; Szibor ef al., 1998) of direct
mutation rate counts produced:

» Larger sample sizes for some of the NGM " Kit loci.

e Methods for modifications of these mutation rates (to infer mutation rates
indirectly for those loci where the rates are not large enough to be measured
directly and/or to account for those events undetectable as Mendelian errors).

Probability of identity

Table 10 Allele frequencies (%) by population group for NGM™ Kit STR loci. (The + symbol
indicates alleles not detected or, where values appear in parentheses, alleles not detected in
significant quantities.)

Allele African American Caucasian Hispanic
(N = 344) (N = 346) (N = 390)
D1051248
6 (0.15)F i i
7 ' (0.15)F t t
8 t T (0.13)*
9 (0.15)F U (0.13)*
10 (0.157 t (0.13)t
11 ' 3.63 (0.58)* (0.26)
12 13.95 3.47 4.23
13 22.67 29.05 25.51
14 28.2 29.77 36.03
15 18.6 19.65 22.95
16 9.88 13.44 8.08
17 2.18 3.76 2.56
18 (0.29)t (0.29)1 T
19 t + +
20 + t 1
D125391
13 i i (0.13)*
14 | t T (0.13)
15 7.12 419 3.97
15.1 (0.15) U U
16 5.09 3.47 5.13
161 (0.15) T T
17 15.7 10.55 7.31
17.1 (0.44)" U (0.26)1
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Allele African American Caucasian Hispanic
[continued)] (N = 344) (N = 346) (N = 390)
17.3 (0.58% 2.02 1.15
18 25.73 16.18 20
18.3 1.16 217 2.05
19 14.1 12.28 18.59
19.1 (0.58)T T f
19.3 (0.29)* (0.58)* 1.15
20 11.92 9.83 17.31
20.3 T T t
21 6.98 13.73 8.72
213 (0.15) (0.14)t T
22 5.09 10.69 6.92
23 3.34 8.09 3.72
24 (0.58)* 3.61 1.79
25 0.87 2.02 1.28

26 t (0.29)t (0.26)*
27 t (0.14)t (0.13)

28 T T T

D16S539

5 + t t

6 t U (0.13)
7 T T T

8 3.49 1.45 1.92
9 22.24 12.43 10.38
10 11.63 4.05 15.77
1 29.07 32.23 31.92
12 19.33 30.78 24.49
12.2 t t t
13 12.94 17.2 13.97
14 1.31 1.73 1.15
15 T (0.14)1 (0.26)
16 T T T

D18S51

7 + t t

8 T T T

9 t i (0.13)t
9.2 T T t
10 (0.29)F 1.16 0.64
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Allele African American Caucasian Hispanic
[continued] (N = 344) (N = 346) (N = 390)
10.2 (0.15)* t T
11 (0.44)1 0.87 1.15
11.2 t t t
12 6.25 14.74 10.77
12.2 T t T
13 4.07 11.85 11.54
13.2 (0.29)F T T
14 5.81 17.49 15.77
14.2 (0.44)t T (0.13)
15 17.3 15.32 12.31
15.2 i t (0.13)t
16 18.31 11.85 12.82
16.2 T t T
17 15.7 10.98 17.05
17.2 t t t
18 14.1 8.53 8.46
18.2 T t T
19 9.16 434 3.46
19.2 t t t
20 4.22 1.3 1.79
20.2 (0.15)* t T
21 2.03 1.01 2.31
21.2 t t t
22 1.02 (0.29)* 0.64
22.2 T t T
23 (0.29)* (0.29)F (0.51)T
23.2 t t t
24 i * (0.26)1
25 t t (0.13)T
26 1 1t T
27 T t t
D195433

9 (0.29)F t t
9.2 1 1t T
10 1.16 (0.14)t (0.38)1
10.2 (0.15)t T T

11 9.74 t 1.54
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Allele African American Caucasian Hispanic
[continued] (N = 344) (N = 346) (N = 390)
11.2 (0.29)F i (0.26)1
12 10.76 7.23 8.46
12.1 t (0.14)1 i
12.2 3.78 (0.14)1 1.41
13 28.63 27.46 18.72
13.2 5.23 1.59 7.05
14 18.31 34.68 30.38
14.2 5.81 2.17 449
15 6.25 16.18 12.69
15.2 4.22 3.47 7.31
16 1.45 5.92 41
16.2 3.34 (0.29)* 2.31
17 t (0.29) (0.51)1
17.2 (0.58)F (0.14)F (0.38)1
18 t (0.14)1 i
18.2 T T i
D151656
9 (0.15)F i (0.13)1
10 1.31 (0.29)* (0.38)*
11 5.52 5.92 3.85
12 7.99 16.04 9.49
13 11.19 6.65 7.18
14 24.27 6.36 11.03
143 1.02 (0.29)* (0.26)*
15 17.44 15.17 16.03
15.3 1.89 8.53 2.95
16 10.32 9.97 15.26
16.1 t T (0.26)1
16.3 7.27 491 5.26
17 2.62 491 6.92
17.1 T (0.29)F i
17.3 5.96 12.72 15.26
18 (0.44)* (0.29)F 0.77
183 1.89 5.92 4.36
19 (0.15)t i i
19.3 (0.58)" 1.73 0.64
20.3 T T i
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Allele African American Caucasian Hispanic
[continued] (N = 344) (N = 346) (N = 390)
D21511

23.2 T t i
24 t 1 1
24.2 t t -- (0.26)
25 1 T T
25.2 T t i
26 (0.29)* (0.58)* (0.38)*
26.2 T T i
27 5.52 2.75 1.41
27.1 (0.15)* i i
27.2 T T i
28 25.29 16.91 11.03
28.2 i t (0.13)*
29 15.7 23.55 21.15
29.2 t (0.14)1 U
29.3 (0.15) (0.14)* i
30 20.93 23.41 27.95
30.2 1.6 2.75 1.67
31 8.72 6.79 5
31.2 494 8.67 11.28
32 1.31 2.31 1.28
32.2 6.98 9.54 12.44
33 0.87 t --(0.13)
33.2 3.2 2.02 5.26
34 (0.15)F t t
34.2 T (0.431 (0.13)1
35 3.49 t (0.26)1
35.2 T T i
36 0.73 t (0.13)t
36.2 T t t
37 T T 1
37.2 T t i
38 T T (0.13)*
38.2 T t t
39 T T 1
D2251045
5 T T T
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Allele African American Caucasian Hispanic
[continued] (N = 344) (N = 346) (N = 390)
6 t t t
7 + t t
8 0.73 T T
9 t t t
10 4.07 (0.43)* 0.64
1" 14.53 13.58 7.82
12 5.96 (0.58% 1.03
13 (0.29)F 1.01 1.03
14 8.58 3.47 2.18
15 23.55 36.56 42.56
16 19.91 36.27 35.64
17 20.35 7.51 7.95
18 2.03 (0.58)F 1.03
20 T T (0.13)*

D2S1338
13 (0.15)t (0.14)F T
14 T (0.14)F T
15 (0.29)t (0.14) t
16 5.23 419 3.59
17 10.03 18.79 17.69
18 4.8 8.38 6.54
19 15.99 14.31 17.82
20 10.03 15.46 13.72
21 12.79 2.75 3.59
22 12.65 1.73 6.28
23 9.3 10.12 14.87
24 8.58 9.97 8.85
25 6.98 11.85 5.38
26 2.47 1.73 1.41
27 0.73 (0.29) (0.13)F
28 t i (0.13)
29 T T t
D2S441

8 (0.15)F T T

9 t (0.58)1 (0.26)1
10 8.87 19.8 31.15
1 35.03 33.82 31.67
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Allele African American Caucasian Hispanic
[continued] (N = 344) (N = 346) (N = 390)
11.3 3.34 5.06 4.36
12 20.06 4.05 3.97
12.3 (0.15)F (0.29)* (0.38)*
13 3.63 3.18 1.92
133 t t t
14 ' 26.89 28.32 22.56
14.3 i t t
15 1.89 448 3.33
16 t (0.26)1 (0.38)*
17 T T T
D351358
9 (0.29)* i (0.13)*
11 i (0.29)* t
12 (0.15)t T (0.13)F
13 (0.58)" (0.14)* (0.38)*
14 9.16 15.17 9.49
15 28.34 27.31 34.49
152 (0.29)F t t
16 32.85 23.99 26.54
16.2 t t i
17 22.09 19.8 17.95
17.2 i t i
18 5.81 11.85 10.13
18.2 t t i
19 (0.44)1 1.45 0.77
20 T T T
D851179

7 T T T

8 (0.44) 2.02 0.64
9 ' (0.29)F 13 (0.26)1
10 3.34 10.84 9.49
11 5.81 6.65 4.87
12 11.05 15.03 12.44
13 ' 18.31 33.53 33.33
14 36.05 18.64 23.46
15 17.73 8.67 11.54
16 5.96 2.89 3.33
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Allele African American Caucasian Hispanic
[continued] (N = 344) (N = 346) (N = 390)
17 1.02 (0.43)* 0.64
18 t + +
19 t T t
20 T T T
FGA
16 i (0.14)F i
16.1 (0.29)* i i
16.2 t t t
17 i (0.14)F i
17.2 i t i
18 0.87 1.16 0.64
18.2 0.73 t t
19 6.83 5.35 7.82
19.2 (0.44)t t i
20 6.69 15.61 8.72
20.2 (0.29)* (0.43)* (0.26)1
21 12.06 18.35 13.59
21.2 (0.15)F (0.29)F U
22 18.17 18.93 14.1
22.2 (0.15)* 0.87 0.64
23 16.86 14.6 12.69
23.2 T (0.43)F (0.38)1
23.3 (0.29)* i i
24 18.75 14.31 15.9
24.2 i i i
25 9.3 6.79 14.1
25.2 i t i
26 3.92 1.88 6.79
26.2 i i i
27 2.62 (0.58)F 2.95
27.2 i t i
28 1.16 (0.14)F 0.9
- T T T
29 i T (0.38)1
29.2 i t i
30 (0.15) t (0.13)
30.2 (0.15) T i
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Allele African American Caucasian Hispanic

(continued)
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Allele African American Caucasian Hispanic
[continued)] (N = 344) (N = 346) (N = 390)
VWA

10 T T T
11 (0.44)" U (0.13)*
12 t T (0.26)1
13 0.73 (0.14)1 (0.13)*
1% 7.41 8.38 6.41
15 20.93 12.14 9.87
15.2 t t i
16 27.47 22.69 30
17 ' 19.48 27.31 27.18
17.3 t i (0.13)*
18 13.81 18.06 18.46
18.2 i T i
19 6.98 9.97 6.67
20 2.03 13 0.77
21 (0.58)" i i
22 T T T
23 (0.15)F t t
24 t T t
25 T T T

t A minimum allele frequency (0.7% for the African-American database, 0.7% for the U.S. Caucasian
database, 0.9% for the U.S. Hispanic database, and 1.3% for the Native American database) is suggested
by the National Research Council in forensic calculations.

Table 11 shows the allele frequencies at NGM"" Kit loci by population group. The P;
value is the probability that two individuals selected at random will have an identical
NGM ™ Kit genotype (Sensabaugh, 1982). The P; values for the populations described
in this section are then 6.74 X 10 -20 ng/lL-22 (African-American), 2.76 X 10 19 (U.S.
Caucasian) and 4.00 X 10 12 (U.S. Hispanic).

Table 11 Probability of identity (P} values for the NGM™ Kit STR loci

Locus African-American U.S.-Caucasian U.S.-Hispanic
(N = 344) (N = 346) (N = 390)
D10S1248 0.069 0.094 0.111
VWA 0.062 0.065 0.091
D165539 0.072 0.104 0.082
D251338 0.023 0.032 0.032
D8S1179 0.076 0.063 0.068
D21511 0.045 ' 0.052 ' 0.050
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Probability of paternity exclusion

Locus African-American U.S.-Caucasian U.S.-Hispanic
(N = 344) (N = 346) (N = 390)
D18S51 0.031 0.031 0.028
D2251045 0.056 0.133 0.161
D195433 0.040 0.085 0.048
THO1 0.09% 0.080 0.091
FGA 0.033 0.039 0.028
D2S441 0.101 ' 0.098 ' 0.107
D351358 0.100 0.075 0.095
D151656 0.034 0.022 0.025
D125391 0.039 0.023 0.032
Combined 6.74 x 10 ~20 ' 2.76 x 1019  400x 1019

Probability of paternity exclusion

Table12 Probability of Paternity Exclusion values for the NGM™ Kit™ STR loci

Locus African-American Caucasian Hispanic
(N = 344) (N = 346) (N = 390)
D10S1248 0.659 0.568 0.469
VWA 0.603 0.644 0.638
D16S539 0.556 0.579 0.557
D251338 0.798 0.752 0.738
D8S1179 0.587 0.616 0.557
D21S11 0.727 0.729 0.692
D18S51 0.786 0.758 0.718
D2251045 0.698 0.455 0.397
D19S433 0.636 0.507 0.647
THO1 0.515 0.502 0.539
FGA 0.727 0.666 0.708
D2S441 0.522 0.497 0.477
D351358 0.476 0.522 0.482
D151656 0.745 0.811 0.723
D12S391 0.745 0.799 0.662
Combined 0.999999931 0.999999835 0.999999376

The Pg value is the probability, averaged over all possible mother-child pairs, that a
random alleged father will be excluded from paternity after DNA typing of the NGM "™
Kit STR loci (Chakraborty, Stivers, and Zhong, 1996).
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Troubleshooting

Follow the actions recommended in this appendix to troubleshoot problems that occur

during analysis.

Observation

Possible causes

Recommended actions

Faint or no signal from
both, the 007
AmpF(STR™ Control
DNA and the DNA test
samples at all loci

Incorrect volume or absence of either
AmpF(STR™ NGM™ Master Mix or
AmpF(STR™ NGM™ Primer Set

Repeat amplification using correct reagent
volumes.

No activation of enzyme

Repeat amplification, making sure to hold
reactions initially at 95°C for 11 min.

Master Mix not vortexed thoroughly
before aliquoting

Vortex Master Mix thoroughly.

AmpF(STR™ NGM™ Primer Set
exposed to too much light

Store Primer Set protected from light.

GeneAmp™ PCR System malfunction

Refer to the thermal cycler user’s manual and
check instrument calibration.

Incorrect thermal cycler parameters

Check the protocol for correct thermal cycler
parameters.

Tubes/plate not seated tightly in the
thermal cycler during amplification

Push reaction tubes/plate firmly into contact with
block after first cycle. Repeat test.

Wrong PCR reaction tubes or plate

Use Applied Biosystems™ MicroAmp Reaction
Tubes with Caps or the MicroAmp Optical 96-
Well Reaction Plate for the GeneAmp™ PCR
System 9700 or Veriti™ 96-well Thermal Cycler.

MicroAmp™ Base used with tray/
retainer set and tubes in
GeneAmp™ PCR System 9700

Remove MicroAmp Base from tray/retainer set
and repeat test.

Insufficient PCR product
electrokinetically injected

Refer to Chapter 3, “Electrophoresis” on page 25,
for instructions on recommended actions on the
ABI PrisM™ 3100/ 3100-Avant or

Applied Biosystems™ 3130/3130x(, 3500/ 3500xL,
and the ABI PrisM™ 310 instruments.

Degraded formamide

Check the storage of formamide; do not thaw and
refreeze multiple times. Try Hi-Di™ Formamide.
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Observation

Possible causes

Recommended actions

Positive signal from
AmpF(STR™ Control
DNA 007 but partial or
no signal from DNA
test samples

Quantity of test DNA sample is below
assay sensitivity

Quantify DNA and add either 1.0 ng or 500 pg of
DNA depending upon cycle number being used.
Repeat test.

Test sample contains high
concentration of PCR inhibitor (for
example, heme compounds, certain
dyes

Quantify DNA and add minimum necessary
volume. Repeat test.

Wash the sample in a Centricon™-100 centrifugal
filter unit. Repeat test.

Test sample DNA is severely
degraded

If possible, evaluate the quality of DNA sample by
running an agarose gel. If DNA is degraded,
reamplify with an increased amount of DNA or
use the AmpF(STR™ MiniFiler™ Kit.

Dilution of test sample DNA in water
or wrong buffer (for example, TE
formula with incorrect EDTA
concentration)

Redilute DNA using low-TE Buffer (with 0.1 mM
EDTA.

More than two alleles
present at a locus

Presence of exogenous DNA

Use appropriate techniques to avoid introducing
foreign DNA during laboratory handling.

Amplification of stutter product

Mixed sample

Interpret according to laboratory procedures.

Note: Additional information will be provided on
completion of validation.

Incomplete 3" A base addition
(n-1 nt position)

Addition of excess DNA to the reaction will
contribute to the occurrence of incomplete 3’ base
addition. Quantify DNA and add 1.0 ng of DNA to
the reaction. Repeat test. Also be sure to include
the final extension step of 60°C for 10 min in the
PCR.

Signal exceeds dynamic range of
instrument (off-scale data)

Ensure cycle number is optimized according to
instructions on page 22. Repeat PCR amplification
using fewer PCR cycles or use your laboratory’s
SOP to analyze off-scale data.

Poor spectral separation (bad matrix)

Follow the steps for creating a spectral file.

Confirm that Filter Set G5 modules are installed
and used for analysis.

Too much DNA in reaction

Use recommended amount of template DNA:
1.0 ng at 29 cycles; 500 pg at 30 cycles.

Incomplete denaturation of double
stranded DNA

Use the recommended amount of Hi-Di™
Formamide and perform heat denaturation
according to instructions in Chapter 3,
“Electrophoresis”.

Poor peak height

Incorrect thermal cycler parameters

Check the protocol for correct thermal cycler

balance parameters.
GeneAmp™ PCR System 9700 Use Applied Biosystems™ GeneAmp™ PCR
with Aluminum 96-Well block or System 9700 with silver, gold-plated silver
third-party thermal cyclers blocks or Veriti™ 96-well Thermal Cycler only.
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Ordering Information

The tables below list optional equipment and materials not supplied with the NGM™
Kit. Unless otherwise noted, many of the items are available from major laboratory

suppliers (MLS).

Equipment

Part number

Applied Biosystems™ 3500/3500xL Genetic Analyzer for Human Identification

ABI PRIsM™ 3100/3100-Avant Genetic Analyzer

Contact your local
Life Technologies

Applied Biosystems™ 3130/3130x( Genetic Analyzer :;:llisesentative
Applied Biosystems™ 310 Genetic Analyzer

GeneAmp™ PCR System 9700 with the Silver 96-Well Block N8050001
GeneAmp™ PCR System 9700 with the Gold-plated Silver 96-Well Block 4314878
Silver 96-Well Sample Block N8050251
Gold-plated Silver 96-Well Sample Block 4314443
Veriti™ 96-well Thermal Cycler 4375786
ProFlex™ 96-Well PCR System 4484075
Tabletop centrifuge with 96-Well Plate Adapters (optional) MLS

Item

Part number

3500/3500xL Analyzer materials

Anode buffer container (ABC) 4393927
Cathode buffer container (CBC) 4408256
POP-4™ polymer (960 samples) for 3500/3500xL Genetic Analyzers 4393710
POP-4™ polymer (384 samples) for 3500/3500xL Genetic Analyzers 4393715
Conditioning reagent 4393718
8-Capillary array, 36 cm for 3500 Genetic Analyzers 4404683
24-Capillary array, 36 cm for 3500xL Genetic Analyzers 4404687
96-well retainer & base set (Standard) 3500/3500xL Genetic Analyzers 4410228
8-Tube retainer & base set (Standard) for 3500/3500xL Genetic Analyzers 4410231
8-Strip Septa for 3500/3500xL Genetic Analyzers 4410701
96-Well Septa for 3500/3500xL Genetic Analyzers 4412614
Septa Cathode Buffer Container, 3500 series 4410715
GeneScan™ 600 LIZ™ Size Standard v2.0 4408399
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Item Part number

Note: For a complete list of parts and accessories for the 3500/3500xL instrument, refer to the
Applied Biosystems ™ 3500/3500xL Genetic Analyzer User Guide (Part no. 4401661)

AmpF(STR™ NGM™ PCR Amplification Kit (200x/1000x) 4415020/4415021
3100/3100-Avant Analyzer materials
96-Well Plate Septa 4315933
Reservoir Septa 4315932
3100/3100-Avant Genetic Analyzer Capillary Array, 36-cm 4333464
POP-4™ Polymer for 3100/3100-Avant Genetic Analyzers 4316355
3100/3100-Avant Genetic Analyzer Autosampler Plate Kit, 96-well 4316471
GeneScan™ 500 LIZ™ Size Standard Or 4322682
GeneScan™ 600 LIZ™ Size Standard v2.0 Or
4408399
Running Buffer, 10X 402824
DS-33 Matrix Standard Kit (Dye Set G5) 4345833
MicroAmp™ Optical 96-Well Reaction Plate N8010560
250-uL Glass Syringe (array-fill syringe) 4304470
5.0-mL Glass Syringe (polymer-reserve syringe) 628-3731

Note: For a complete list of parts and accessories for the 3100 instrument, refer to Appendix B of the ABI
Prism™ 3100 Genetic Analyzer and 3100-Avant Genetic Analyzer User Reference Guide (Part no. 4335393).

3130/3130x! Analyzer materials

96-Well Plate Septa 4315933
Reservoir Septa 4315932
3100/3130x! Genetic Analyzer Capillary Array, 36-cm 4315931
POP-4™ Polymer for 3130/3130x( Genetic Analyzers 4352755
3130/3130x! Genetic Analyzer Autosampler Plate Kit, 96-well 4316471
GeneScan™ 500 LIZ™ Size Standard Or 4322682
GeneScan™ 600 LIZ™ Size Standard v2.0 or
4408399
Running Buffer, 10X 402824
DS-33 Matrix Standard Kit (Dye Set G5) 4345833
MicroAmp™ Optical 96-Well Reaction Plate N8010560

For a complete list of parts and accessories for the 3130x( instrument, refer to Appendix A of the Applied Biosystems
3130/3130x( Genetic Analyzers Maintenance, Troubleshooting, and Reference Guide (Part no. 4352716).

310 DNA Analyzer materials

310 DNA Analyzer Capillary Array, 47-cm 402839
0.5 mL Sample Tray 5572
96-Well Tray Adaptor (for 9700 thermal cycler trays) 4305051
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Item Part number
GeneScan™ 500 LIZ™ Size Standard Or 4322682
GeneScan™ 600 LIZ™ Size Standard v2.0 or
4408399
Running Buffer, 10X 4335643
Genetic Analyzer Septa Retainer Clips for 96-Tube Sample Tray 402866
Genetic Analysis Sample Tubes (0.5-mL]) 401957
Septa for 0.5-mL Sample Tubes 401956
DS-33 Matrix Standard Set (6-FAM™, VIC™, NED™, PET™, and LIZ"™ dyes) for 4318159
ABI PRISM™ 310/377 systems
MicroAmp™ 8-Tube Strip, 0.2-mL N8010580
MicroAmp™ 96-Well Base (holds 0.2-mL reaction tubes) N8010531
MicroAmp™ 96-Well Full Plate Cover N8010550
MicroAmp™ 96-Well Tray/Retainer Set 403081
POP-4™ Polymer for the 310 Genetic Analyzer 402838

For a complete list of parts and accessories for the 310 instrument, refer to Appendix B of the ABI PRISM™ 310

Genetic Analyzer User Guide (Part no. 4317588).

PCR Amplification

MicroAmp™ 96-Well Tray N8010541
MicroAmp™ Reaction Tube with Cap, 0.2-mL N8010540
MicroAmp™ 8-Tube Strip, 0.2-mL N8010580
MicroAmp™ 8-Cap Strip N8010535
MicroAmp™ 96-Well Tray/Retainer Set 403081
MicroAmp™ 96-Well Base N8010531
MicroAmp™ Clear Adhesive Film 4306311
MicroAmp™ Optical Adhesive Film 4311971
MicroAmp™ Optical 96-Well Reaction Plate N8010560
Other user-supplied materials

Hi-Di™ Formamide, 25-mL 4311320
Aerosol resistant pipette tips MLS
Microcentrifuge tubes MLS
Pipettors MLS
Tape, labeling MLS
Tube, 50-mL Falcon MLS
Tube decapper, autoclavable MLS
Deionized water, PCR grade MLS
Tris-HCL, pH 8.0 MLS
EDTA, 0.5 M MLS
Vortex MLS
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PCR Work Areas

Work area setup and labdesign............ ... i 111
PCRsetupworkarea......... ... 111
Amplified DNA workarea . ..............uuuuiiiiiiiiinnnn 112

Work area setup and lab design

Many resources are available for the appropriate design of a PCR laboratory. If you
are using the AmpF(STR™ NGM ™ PCR Amplification Kit for:

e Forensic DNA testing, refer to “Forensic Laboratories: Handbook for Facility
Planning, Design, Construction and Moving,” National Institute of Justice, 1998
(www.nij.org/publications)

* Parentage DNA testing, refer to the “Guidance for Standards for Parentage
Relationship Testing Laboratories,” American Association of Blood Banks, 7th
edition, 2004

The sensitivity of the NGM " Kit (and other PCR-based tests) enables amplification of
minute quantities of DNA, necessitating precautions to avoid contamination of
samples yet to be amplified (Kwok and Higuchi, 1989).

Also take care while handling and processing samples to prevent contamination by
human DNA. Wear gloves at all times and change them frequently. Close sample tubes
when not in use. Limit aerosol dispersal by handling sample tubes and reagents
carefully.

Note: We do not intend these references for laboratory design to constitute all
precautions and care necessary for using PCR technology.

PCR setup work area

IMPORTANT! These items should never leave the PCR Setup Work Area.

e Calculator

* Gloves, disposable

¢ Marker pen, permanent
¢ Microcentrifuge

* Microcentrifuge tubes, 1.5-mL, or 2.0-mL, or other appropriate clean tube (for
Master Mix preparation)

* Microcentrifuge tube rack

* Pipette tips, sterile, disposable hydrophobic filter-plugged
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Appendix C PCR Work Areas
Amplified DNA work area

¢ DPipettors
¢ Tube decapper, autoclavable

e Vortex

Amplified DNA work area

IMPORTANT! Place the thermal cyclers in the Amplified DNA Work Area.

You can use the following systems:

* GeneAmp'" PCR System 9700 with the Silver 96-Well Block
e GeneAmp " PCR System 9700 with the Gold-plated Silver 96-Well

DI~ 1.

IMPORTANT! The NGM"™ Kit is not validated for use with the GeneAmp™"
PCR System 9700 with the Aluminium 96-Well Block. Use of this thermal

cycling platform may adversely affect performance of the NGM ™ Kit.

e Veriti"" 96-well Thermal Cycler
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Safety

WARNING! GENERAL SAFETY. Using this product in a manner not specified
in the user documentation may result in personal injury or damage to the
instrument or device. Ensure that anyone using this product has received
instructions in general safety practices for laboratories and the safety
information provided in this document.

* Before using an instrument or device, read and understand the safety
information provided in the user documentation provided by the
manufacturer of the instrument or device.

* Before handling chemicals, read and understand all applicable Safety Data
Sheets (SDSs) and use appropriate personal protective equipment (gloves,
gowns, eye protection, etc). To obtain SDSs, see the “Documentation and
Support” section in this document.
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Chemical safety

WARNING! GENERAL CHEMICAL HANDLING. To minimize hazards,
ensure laboratory personnel read and practice the general safety guidelines for
chemical usage, storage, and waste provided below, and consult the relevant
SDS for specific precautions and instructions:

Read and understand the Safety Data Sheets (SDSs) provided by the
chemical manufacturer before you store, handle, or work with any chemicals
or hazardous materials. To obtain SDSs, see the “Documentation and
Support” section in this document.

Minimize contact with chemicals. Wear appropriate personal protective
equipment when handling chemicals (for example, safety glasses, gloves, or
protective clothing).

Minimize the inhalation of chemicals. Do not leave chemical containers
open. Use only with adequate ventilation (for example, fume hood).

Check regularly for chemical leaks or spills. If a leak or spill occurs, follow
the manufacturer's cleanup procedures as recommended in the SDS.
Handle chemical wastes in a fume hood.

Ensure use of primary and secondary waste containers. (A primary waste
container holds the immediate waste. A secondary container contains spills
or leaks from the primary container. Both containers must be compatible
with the waste material and meet federal, state, and local requirements for
container storage.)

After emptying a waste container, seal it with the cap provided.
Characterize (by analysis if necessary) the waste generated by the particular
applications, reagents, and substrates used in your laboratory.

Ensure that the waste is stored, transferred, transported, and disposed of
according to all local, state/provincial, and/or national regulations.
IMPORTANT! Radioactive or biohazardous materials may require special
handling, and disposal limitations may apply.

Biological hazard safety

g WARNING! Potential Biohazard. Depending on the samples used on this
instrument, the surface may be considered a biohazard. Use appropriate
decontamination methods when working with biohazards.
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Biological hazard safety

WARNING! BIOHAZARD. Biological samples such as tissues, body fluids,
infectious agents, and blood of humans and other animals have the potential to
transmit infectious diseases. Follow all applicable local, state/provincial, and/or
national regulations. Wear appropriate protective equipment, which includes
but is not limited to: protective eyewear, face shield, clothing/lab coat, and
gloves. All work should be conducted in properly equipped facilities using the
appropriate safety equipment (for example, physical containment devices).
Individuals should be trained according to applicable regulatory and company/
institution requirements before working with potentially infectious materials.
Read and follow the applicable guidelines and/or regulatory requirements in
the following:

In the U.S.:

¢ U.S. Department of Health and Human Services guidelines published in
Biosafety in Microbiological and Biomedical Laboratories found at:
www.cdc.gov/biosafety

* Occupational Safety and Health Standards, Bloodborne Pathogens
(29 CFR§1910.1030), found at: www.access.gpo.gov/nara/cfr/waisidx_01/
29c¢fr1910a_01.html

* Your company’s/institution’s Biosafety Program protocols for working with/
handling potentially infectious materials.

¢ Additional information about biohazard guidelines is available at:
www.cdc.gov

In the EU:

Check local guidelines and legislation on biohazard and biosafety precaution
and refer to the best practices published in the World Health Organization
(WHO) Laboratory Biosafety Manual, third edition, found at: www.who.int/
csr/resources/publications/biosafety/ WHO_CDS_CSR_LYO_2004_11/en/
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Documentation and Support

Related documentation

The following related documents are shipped with the system:

Document Part number
ABI PrisM™3100/3100-Avant Data Collection v2.0 User Guide 4347102
ABI Prism™ 3100/3100-Avant Genetic Analyzers Using Data 4350218
Collection Software v2.0 User Bulletin
ABI PrisM™ 3100 Genetic Analyzer User Manual [Data Collection v1.1) 4315834
ABI Prism™ 3100/3100-Avant Genetic Analyzers Protocols for Processing 4332345

AmpFISTR™ PCR Amplification Kit PCR Products User Bulletin
AmpFISTR™NGM™ PCR Amplification Kit - PCR Setup Quick Reference Card 4442401

AmpFISTR™ NGM™ PCR Amplification Kit - CE Quick Reference Card 4442693
Veriti™ 96-Well Thermal Cycler AmpFISTR™ Kit Validation User Bulletin 4L4LLOT54
ProFlex™ PCR System Kit Validation User Bulletin 100031595
Applied Biosystems'" 3130/3130x( Genetic Analyzers Using Data 4363787
Collection Software v3.0 User Bulletin

Applied Biosystems™ 3130/3130x( Genetic Analyzers Getting Started Guide 4352715
Applied Biosystems™ 3130/3130x( Genetic Analyzers 4352716
Maintenance, Troubleshooting, and Reference Guide

Applied Biosystems™ 3130/3130x! Genetic Analyzers Quick Reference Card 4362825
Applied Biosystems™ 3130/3130xl Genetic Analyzers AB Navigator 4359472
Software Administrator Guide

Applied Biosystems™" 3130/3130xl DNA Analyzers User Guide 4331468
Applied Biosystems™" 3730/3730x( Genetic Analyzer Getting Started Guide 4359476

Quantifiler™ Kits: Quantifiler™ Human DNA Quantification Kit and 4344790
Quantifiler ™Y Human Male DNA Quantification Kit User’s Manual

Identifiler ™™ Forensic DNA Extraction Kit User Guide 4390932
GeneMapper™ ID Software Version 3.1 Human Identification Analysis User 4338775
Guide

GeneMapper™ ID Software Versions 3.1 and 3.2 Human 4335523
Identification Analysis Tutorial

Installation Procedures and New Features for GeneMapper™ ID 4352543
Software v3.2 User Bulletin

GeneMapper™ ID-X Software Version 1.0 Getting Started Guide 4375574
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Obtain support

Document Part number

GeneMapper™ ID-X Software Version 1.0 Quick Reference Guide 4375670
GeneMapper™ ID-X Software Version 1.0 Reference Guide 4375671
GeneMapper™ ID-X Software Version 1.1 (Mixture Analysis) Getting 4396773
Started Guide

GeneMapper™ ID-X Software Version 1.1 [Mixture Analysis) Quick 4402094
Reference Guide

GeneMapper™ ID-X Software Version 1.2 Quick Reference Guide 4426482
GeneMapper™ ID-X Software Version 1.2 Reference Guide 4426481

Note: To open the user documentation, use the Adobe™ Reader™ software
available from www.adobe.com

Note: For additional documentation, see “Obtain support” on page 118.

Obtain support

For HID support:

¢ In North America — Send an email to HIDTechSupport@lifetech.com, or call
888.821.4443 option 1.

* Outside North America — Contact your local support office.
For the latest services and support information for all locations, go to:
www.lifetechnologies.com

At the website, you can:

¢ Access worldwide telephone and fax numbers to contact Technical Support and
Sales facilities

* Search through frequently asked questions (FAQs)
* Submit a question directly to Technical Support

* Search for user documents, SDSs, vector maps and sequences, application notes,
formulations, handbooks, certificates of analysis, citations, and other product
support documents

* Obtain information about customer training

e Download software updates and patches

Limited product warranty

Life Technologies Corporation and/or its affiliate(s) warrant their products as set forth in the Life Technologies' General
Terms and Conditions of Sale found on Life Technologies' website at www.thermofisher.com/us/en/home/global/terms-
and-conditions.html. If you have any questions, please contact Life Technologies at www.thermofisher.com/support.
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